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The FCC Caution

This device complies with Part15 of the FCC Rules. Operation is subject to the following two conditions: (1) This 
device may not cause harmful interference, and (2) this device must accept any interference received, including 
interference that may cause undesired operation.

The FCC Regulation Warning

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of 
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential 
installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in 
accordance with the instructions, may cause harmful interference to radio communications. However, there is no 
guarantee that interference will not occur in a particular installation. If this equipment does cause harmful 
interference to radio or television reception, which can be determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.

- Increase the separation between the equipment and receiver.

- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

- Consult the dealer or an experienced radio/TV technician for help.

Unauthorized changes or modification to this system can void the user's authority to operate this equipment.

Canada

This Class B digital apparatus complies with Canadian ICES-003.

Cet appareil numerique de la classe B est conforme a la norme NMB-003 du Canada.

CE mark for European Harmonized Standards

CE mark which is attached to our company’s products of AC mains operated apparatus until December 31, 1996 
means it conforms to EMC Directive (89/336/EEC) and CE mark Directive (93/68/EEC).

And, CE mark which is attached after January 1, 1997 means it conforms to EMC Directive (89/336/EEC), CE mark 
Directive (93/68/EEC), and Low Voltage Directive (73/23/EEC).

Also, CE mark which is attached to our company’s products of battery operated apparatus means it conforms to EMC 
Directive (89/336/EEC) and CE mark Directive (93/68/EEC).

Trademarks

ADAT, ADAT XT, and BRC are registered trademarks of Alesis, Inc.; RD-8 and CX-8 are registered trademarks of the 
Fostex, Inc.; MDA-1 is a registered trademark of Panasonic, Inc; Apple and MacOS are registered trademarks of Apple 
Computer, Inc.; Windows 95 and Windows 98 are registered trademarks of Microsoft Corp. All other company names, 
brand names, product names, and names of formats etc. are the trademarks or registered trademarks of their 
respective owners.

Licensor Indications

Certain synthesis algorithms in this product were developed under license of physical modeling patents (listed in 
http://www.sondius-XG.com) owned by Stanford University, USA, and by Yamaha Corporation. Sondius-XG 
Technology rights provided under license from Staccato Systems, Inc. (www.Staccatosys.com). 

Third-Party Products

Mention of third-party products is for informational purposes only and constitutes neither an endorsement nor a 
recommendation. Korg assumes no responsibility with regard to the performance or use of these products.

Manual Version: 7/23/01
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OASYS PCI
Thank you!

Thank you for purchasing the Korg Soundlink DRS OASYS PCI.

The OASYS PCI integrates high-quality synthesis, effects processing, and 
computer audio input and output into a single, professional PCI audio card–the 
perfect complement to any MIDI sequencer or software-based digital audio 
workstation.

State of the art DSP synthesis
The OASYS PCI’s synthesizers represent a continual evolution from Korg’s 
pioneering efforts in DSP synthesis, with many improvements and additions. 

Synthesis algorithms are plug-ins loaded from disk, allowing easy upgrades and 
expansion. Korg and third-party sound developers can easily introduce new 
algorithms, or even entirely new types of synthesis.

Incredible effects processing
The OASYS PCI starts with all of the effects of the award-winning Korg Trinity 
workstation, and builds from that foundation. Effects can be used to process the 
onboard synthesizer, tracks from digital audio programs, and live audio inputs, 
and can be used on channel inserts, as sends, and on output busses. As with 
synthesis algorithms, all effects are plug-ins loaded from disk, allowing for easy 
expansion in the future.

Professional, multi-format analog and digital I/O
The OASYS PCI features a total of 12 inputs and outputs - stereo analog, stereo 
S/PDIF, and eight-channel ADAT optical. All inputs and outputs are 24-bit, and all 
can be used simultaneously with compatible multitrack audio software. Word 
clock and ADAT timecode I/O allow easy integration with other digital audio 
equipment.

Seamless integration with MIDI and digital audio software
The OASYS PCI supports all major audio and MIDI standards, for compatibility 
with virtually every audio and MIDI program. 

The output of the synthesizers and effects can be recorded directly into digital 
audio software, without any external connections. The OASYS PCI Editor software 
allows configuration of all mixing, effects, and synthesis parameters, so that no 
special support is necessary from any digital audio program.
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Designed to collaborate with your CPU
You can use your favorite PowerPC or Pentium-based effects plug-ins, such as VST, 
MAS, and DirectX plug-ins, simultaneously with OASYS PCI effects and 
synthesizers.

Complete automation via MIDI
Every parameter in the OASYS PCI can be modulated via standard MIDI 
controllers, allowing easy automation of mixing, synthesis, and effects from any 
MIDI sequencer.
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About This Manual
This Users Guide explains the basic functionality of the OASYS PCI, and is 
divided into two main sections. 

Using the OASYS PCI
This section offers step-by-step instructions for performing specific tasks and 
achieving specific goals with the OASYS PCI.

Look to the Using the OASYS PCI System section to answer the question, “how do 
I do this?”

Reference
This section describes every window, parameter, and menu command in the 
OASYS PCI, with the exception of algorithm-specific Patch and Effect Control 
Panel parameters. 

Use the Reference section to answer the question, “what does this do?”

Other OASYS PCI Manuals

Installation Guide
The Installation Guide provides a brief overview of the product, software and 
hardware installation instructions, and problem-solving resources. It is provided 
in both hard-copy and Adobe Acrobat (.pdf) format.

Patches and Effects Guide
The Patches and Effects Guide includes complete descriptions of the Control Panel 
parameters for each Patch and Effect. It is provided in Adobe Acrobat (.pdf) 
format, which you may read online or print out, as you wish.

OASYS PCI FAQ
FAQ stands for “Frequently Asked Questions.” The OASYS PCI FAQ, which is 
automatically installed with the OASYS PCI software, contains a complete website 
devoted to troubleshooting, setup and compatibility with third-party software and 
hardware, and usage tips. 

The FAQ is in HTML format, so that it can be read by any standard web browser, 
such as Netscape Navigator or Internet Explorer. To search through the FAQ, start 
by opening the document named “OASYS PCI_faq_index.htm.”

In addition to the FAQ installed with the OASYS PCI software, the latest version 
can always be found at the Korg website, at http://www.korg.com.
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Instant Gratification
Loading and playing Multis

Now that you’ve installed the OASYS PCI hardware and software, let’s play some 
sounds!

1. Make sure that the analog outputs of the OASYS PCI are connected to your 
mixer or sound system, and that your MIDI controller (keyboard, guitar, 
etc.) is connected to your computer, and is set to transmit on MIDI channel 
1.

The Korg preset Multis respond to MIDI channel 1, and play from the card’s 
analog outputs. 

If you are using OASYS PCI with Windows, skip to step 3. 

If you are using OASYS PCI with MacOS, follow step 2:

2. If you have set up the OASYS PCI to use OMS, follow the instructions 
under “Using the OASYS PCI Editor as a stand-alone OMS program” in the 
Installation Guide. After this, go on to step 3. 
or
If you have set up the OASYS PCI to use FreeMIDI, follow the instructions 
under “Using the OASYS PCI Editor as a stand-alone FreeMIDI program” 
in the Installation Guide. After this, go on to step 3.
or
If you have set up the OASYS PCI to use the standard serial MIDI 
interface, go on to step 3.

The installer program will have opened two folders on the desktop. One of these is 
named “OASYS PCI Demo Multis.” This folder contains a number of demo 
sounds, which show off different aspects of the OASYS PCI. 

In Windows, the Demo Multis folder is also installed in the Start menu, for easy 
access.

3. Open one of the demo Multis, by double-clicking its icon on the desktop. 

The OASYS PCI Editor will open, and the selected Multi will appear. Multis are 
complete setups for the OASYS PCI, including all of the settings for the onboard 
digital mixer, along with all settings for synthesizer sounds and effects.

4. Play on your MIDI controller.

Enjoy! 

When you’d like to hear another sound:

5. If you’ve opened any other windows, make sure that the main Mixer 
window is in the foreground.

6. Select Close from the File menu.
6 OASYS PCI
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The window will close. Since you closed the main Mixer window, the Multi will 
close as well. If you’ve changed anything, a message will appear asking if you’d 
like to save your changes; press the Don’t Save button (MacOS) or the No button 
(Windows).

7. In the desktop, double-click on the icon of another Multi. 
or
Select Open… from the File Menu, and select a new Multi.

As the shampoo bottles say, “repeat as desired.”

After you’re done listening to a few sounds, make sure to read at least the chapter 
“Using the OASYS PCI.” There’s a lot to the OASYS PCI, and we wouldn’t want to 
you miss anything!

Specifically, for more information on loading sounds, see the “Using Multis” 
section. For information on loading effects, see “Using Effects.” 
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What are...?
File Types

The OASYS PCI use a number of different file types to organize and store sounds. 
Each of these types is briefly described below.

Multis
A Multi is a single, complete setup for the OASYS PCI. It includes all of the 
settings for the Mixer windows, and for the Programs, Patches, Effects, and 
Multisamples being used. The Multi also includes settings for all Program Edit 
and Multisample Edit windows, and all Control Panel parameters for the Patches 
and Effects.

To put it another way, Multis store all of the settings in the Mixer, Send Busses, 
Output Busses, Channel Parameters, Program Edit, Control Panel, and 
Multisample Edit windows-everything except for the Preferences and ASIO 
Control Panel windows. 

For more information, please see “Using Multis” on page 13.

Programs
Programs are the basic sounds of the OASYS PCI, and must be placed on a Mixer 
Channel to be played. They play one or two Patches, which can be layered or split 
by key and velocity ranges. They also have up to four Insert Effects, which appear 
in the Mixer Channel. Programs store all Control Panel settings for their Patches 
and Effects.

For more information, please see “Using Programs & Patches” on page 19.

Effects-Only Programs
Effects-Only Programs store all of the Insert Effects for a Mixer Channel, including 
all Effects Control Panel parameters. You can use them to load chains of Effects 
into a Mixer Channel, or to store such chains for use elsewhere.

Effects-Only Programs are just normal Programs without any Patches loaded into 
the Patch slots. Unlike normal Programs, Effects-Only Programs can be used on 
any type of input, including Audio Inputs, Streams, or even other Programs.

In the Korg factory voicing, they will be placed in the Programs section of the 
folder named “Korg FX Programs.”

For more information, please see “Using Effects” on page 23.

Patches
Patches are the basic units of sound creation on the OASYS PCI. They must be 
placed in a Program in order to be played. Each Patch contains its own synthesis 
algorithm, which may be quite different from one Patch to another. The Patch 
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Control Panel allows you to edit the parameters of a Patch; those parameters may 
be very different, depending on the Patch’s synthesis algorithm. 

For more information, see “Using Programs & Patches” on page 19.

Effects
Effects are used to modify the sound of Patches, Audio Inputs, or Streams. They can 
be used as insert effects in the Mixer Channels and Output Busses, or as send effects 
via the Send Busses. 

Each Effect contains its own audio processing algorithm, which may be quite 
different from one Effect to another. The Patch Control Panel allows you to edit the 
parameters of an Effect; those parameters may be very different, depending on the 
Effect’s synthesis algorithm.

For more information, see “Using Effects” on page 23.

Samples
A Sample is an audio file, which can be placed in a Multisample (see below) and 
then played back by sample-based OASYS PCI Patches. OASYS PCI recognizes 16-
bit and 24-bit samples in a number of different formats, including AIFF, WAV, 
Sound Designer II (on MacOS only), and Korg’s proprietary .kes format.

For more information, see “Using Samples & Multisamples” on page 35.

Multisamples
Multisamples are collections of one or more Samples assigned to ranges across the 
keyboard. Each key range has offsets for common parameters, such as volume, pan, 
filter cutoff, decay, and so on, which can be used to adjust Patch parameters 
individually for each Sample. 

For more information, see “Using Samples & Multisamples” on page 35.

OASYS PCI Editor
The OASYS PCI Editor program allows you to control all of the sound production 
and audio processing aspects of the OASYS PCI, including all mixer settings, 
loading of Programs and Effects, and all Program, Patch, and Effects parameters. 

If you are using the OASYS PCI in conjunction with a digital audio program, you 
should leave the OASYS PCI Editor running in the background, so that you can 
switch to it for editing Programs and Effects.

OASYS PCI Engine
The OASYS PCI Engine controls the low-level functions of the OASYS PCI system, 
such as sending and receiving MIDI, playing sounds, and so on. It will 
automatically start up whenever the OASYS PCI is being used, and will 
automatically quit again when it is not. On MacOS systems, it’s located in the 
System Extensions folder; on Windows systems, it’s located in the 
windows/system directory.
OASYS PCI 9
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You don’t interact directly with the OASYS PCI Engine itself; instead, you control 
it via the OASYS PCI Editor and any audio and/or MIDI software being used.
10 OASYS PCI



 

Using the OASYS PCI User Interface & Shortcuts

                  
User Interface & Shortcuts
Wherever possible, the OASYS PCI supports standard user interface concepts. 
There are buttons to push, sliders to drag, numerical fields to type in, and so on. 
There are a few items and concepts which bear mentioning, as discussed below.

Volume faders
Double-clicking on a volume fader in a Mixer Channel, Send Bus, or Output Bus 
will set the fader to 0dB (unity gain), a value of 111.

Knobs
Knobs are used in the Mixer windows and the Control Panel. You can move knobs 
by dragging the mouse either up and down, or left and right, as if you were moving 
a slider. They are not designed to be “turned” in a circular motion; doing so will 
produce undesired results! 

For fine control, you can increment and decrement the knob’s value using the up 
and down arrows on the keyboard. You can also type directly into the value box.

Double-clicking on a knob will set it to its 12 o’clock position. For example, double-
clicking on the Mixer’s Pan knobs sets them to 64 (center).

Send knobs are the one exception to this. As with volume faders, double-clicking a 
send knob sets it to 0dB (unity gain), a value of 111.

Value boxes
A value box displays a numerical value, such as a volume level or a filter cutoff. 
You can edit value boxes in several different ways, as described below:

Typing.  You can type directly into the selected value box. Typed edits take effect 
when you press return, tab, or enter; when you click on another value box, or on 
another window; or when you move another knob, slider, button, or menu.

Arrow keys. You can increment and decrement the selected value box by pressing 
the up and down arrow keys on the computer keyboard.

Mouse dragging. You can edit a value box by simply clicking in the box and then 
dragging the mouse up or down, as you were moving a slider. Dragging up 
increments the value, and dragging down decrements the value.

MIDI editing
You can edit some parameters by playing on your MIDI controller. These 
parameters include:

• Key and velocity zones in the Program Edit and Channel Parameters 
windows.

• MIDI controller selections A-H in the Preferences window.
OASYS PCI 11
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• High, low, and base keys in the Multisample Edit window.
To edit these parameters from MIDI, first select the parameter. Once the parameter 
is selected, hold down the Shift key, and then play on your MIDI controller. As 
long as the Shift key is held down, the parameter will continue to accept MIDI 
input.

The Multisample Edit window also has shortcuts to select the High, Low, and Base 
keys; for details, see “Multisample Edit,” beginning on page 93.

Drag-and-drop
To load Programs, Patches, Effects, Multisamples, or Samples, just drag them from 
the Catalog window into the desired slot.

(MacOS only: Alternatively, you can select a slot, and then double-click on the 
name of the item in the Catalog window.)

You can also use drag-and-drop to copy items between slots. Just click on the 
name of the Program, Patch, Effect, Multisample, or Sample that you’d like to 
copy, and drag it to the new location.

Delete key
Pressing the Delete key will remove the currently selected Program, Patch, Effect, 
Multisample, or Sample from the Multi, Program, Patch, or Multisample.

Bypassing Effects
To bypass a single Effect, click on the slot number to the left of the Effect name. 

To bypass all Effects in a Channel, Send, or Output Bus, option-click (MacOS) or 
CTRL-click (Windows) on any of the Effects slot numbers. 

Clearing clip indicators
To clear a meter’s clip indicators, click on them. To clear all clip indicators on the 
Mixer, option-click (MacOS) or CTRL-click (Windows) on any clip indicator.
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Using Multis
Opening a Multi

1. Select Open… from the File menu.

The standard file open dialog will appear.

2. Select the Multi that you want to open, and press OK.

The selected Multi file will be opened. 

You can also open a Multi by double-clicking on a Multi file in the Finder.

Creating a new Multi
To create a new Multi:

1. Select New from the File menu.

This will create a new, empty Multi, and open the Multi’s Mixer window. You can 
then add Programs and Effects to the new Multi, and assign Mixer Channels to 
Audio Inputs or Streams.

Loading a Program into a Multi
To load a Program into a Multi:

1. Open the Catalog, by selecting it from the Windows menu.

2. In the Catalog, select the Program tab.

3. Drag a Program from the Catalog onto the Input slot.

(MacOS Only: Alternatively, you can select the Input slot and then double-click the 
name of the Program in the Catalog.)

The Program appears in the Input slot. If Auto-Load FX is turned on for the Mixer 
Channel, then the Program’s Effects will be loaded into the Insert Effect slots. See 
“Auto-Load FX controls how Effects are loaded” below for more details.

4. Set the MIDI Channel and Output as desired.

5. Double-click on the Program name, in either the Mixer Channel input slot 
or the Channel Parameters window.

This opens the Program Edit window, as described on page 80.

The OASYS PCI uses “fixed voice allocation,” which means that if you want to play 
six-note chords on an electric piano sound, you must tell the system to reserve six 
voices for the Patches within that Program. Conversely, the fewer voices you 
reserve for one Program, the more that will be available for other Programs (or for 
Effects).

6. In the Program Edit window, set each Patch’s number of voices as desired.
OASYS PCI 13
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Connect and Disconnect commands
When adding several Programs in a row, you can speed things up by using the 
Connect and Disconnect commands, as described on page 17.

What if I get an error message?
If you try to add a Program, but get an error message stating that there is not 
enough processing power to play the Multi, you may need to reduce the number 
of voices of the Program (or of other Programs), reduce the number of Effects 
being used, or otherwise free up system resources. 

For more information, please see “Managing Resources,” on page 53.

Auto-Load FX controls how Effects are loaded
Programs store their own Insert Effects. You can use the Mixer Channel’s Auto-
Load FX parameter to control whether or not these Effects will be added to the 
Mixer when the Program is loaded.

If Auto-Load FX is turned on, then the Program’s Effects will be loaded into the 
Insert Effects slots. If there were already Insert Effects on the channel, they will be 
deleted. 

If Auto-Load FX is turned off, then the Program’s Effects will not be loaded, and 
any previously loaded Insert Effects will stay as they were. This is useful if you 
have created a complex Effects setup, and wish to audition different Programs 
using the same Effects. 

Loading an Effects-Only Program into a Multi
Effects-Only Programs store all of the Insert Effects for a Mixer Channel, including 
all Effects Control Panel parameters. You can use them to load chains of Effects 
into a Mixer Channel, or to store such chains for use in other Multis.

Effects-Only Programs are just normal Programs without any Patches loaded into 
the Patch slots. Unlike normal Programs, Effects-Only Programs can be used on 
any type of input, including Audio Inputs, Streams, or even other Programs.

In the Korg factory voicing, they will be placed in the Programs section of the 
folder named “Korg Effects.”

To load an Effects-Only Program:

1. Make sure that FX Auto-Load is enabled on the desired Channel.

FX Auto-Load must be enabled in order to load an Effects-Only Program.

1. Open the Catalog, by selecting it from the Windows menu.

2. In the Catalog, select the Program tab.

3. Drag an Effects-Only Program from the Catalog onto the Input slot.

(MacOS only: Alternatively, you can select the slot and then double-click the name 
of the Effects-Only Program in the Catalog.)
14 OASYS PCI
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The Effects-Only Program will replace any previously loaded Insert Effects. 

Note that unlike normal Programs, loading an Effects-Only Program will not 
change the input to the Channel. If the Channel already contained a Program, the 
original Program’s Patches will play through the new Effects. If the Channel’s input 
was an Audio Input or a Stream, the Input Type will not change, and the audio will 
play through the new Effects. 

Effects-Only Programs can only be used on Mixer Channels
Effects-Only Programs can only be used on Mixer Channels; they cannot be loaded 
directly into Send Busses or Output Busses.

As a workaround, you can load an Effects-Only Program onto a Mixer Channel, 
and then copy the individual Effects onto the desired Send Bus or Output Bus.

Using Insert, Send, and Output Bus Effects
The Multi’s Effects routing capabilities are very powerful–so powerful that they 
have their own section in this manual! See the section titled “Using Effects,” 
beginning on page 23, for more details.

Removing a Program or Effect from a Multi
To remove a Program or Effect from a Multi:

1. Select the Program clicking on its name in the Mixer or Channel Parameters 
window. Or, select the Effect by clicking on its name in the Mixer, Send 
Busses, or Output Busses window.

2. Press the Delete key.

The Program or Effect will be removed from the Multi.

When deleting several Programs or Effects in a row, you may wish to use the 
Connect and Disconnect commands, as described on page 17.

Copying Programs or Effects
You can copy any Program or Effect, including all Control Panel settings, from one 
Channel to another, or from one Multi to another. Simply use drag-and-drop, or use 
the Copy and Paste commands in the Edit menu. To copy from one Multi to 
another, open both Multis and drag-and-drop between them. 

When copying several Programs or Effects in a row, you may wish to use the 
Connect and Disconnect commands, as described on page 17.

Creating splits and layers of two or more Programs
You can use Multis to create complex keyboard and velocity splits and layers 
between two or more Programs. Note that Patches can also be split and layered 
within a single Program, which interacts with the Multi as shown below.
OASYS PCI 15
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Cumulative Program and Patch high/low key windows

Creating layers
To layer Programs in a Multi:

1. In the Mixer window, set the Mixer Channels containing the Programs to 
use the same MIDI channel.

That’s it!

Creating keyboard splits
To create a keyboard split between two or more Programs:

1. In the Mixer window, set the Mixer Channels containing the Programs to 
use the same MIDI channel.

2. In the Channel Parameters window, set the Low Velocity for each of the 
Programs to the minimum (0), and the High Velocity to the maximum (127).

This will make sure that the Programs all respond to the full velocity range.

3. Set the High/Low Key parameters so that each Program is active for only a 
specific keyboard range.

For instance, setting the Low Key to C4 and the High Key to C8 will make the 
Program play only in the upper part of the keyboard.

When the High/Low Key and Velocity parameters are selected, you can press and 
hold the Shift key to edit the values by playing notes on your MIDI controller.

You can create splits using as many different Programs as you like.

Velocity splits
To create a velocity split between two or more Programs:

1. In the Mixer window, set the Mixer Channels containing the Programs to 
use the same MIDI channel.

2. In the Channel Parameters window, set the Low Key for each Program to 
the minimum (C-1), and the High Key to the maximum (G9).

This will make sure that the Programs all respond to the full keyboard range.

Program key window: 

Patch key window: 

Resulting key window: 

Patch

Program

ResultC-1 to A6

C4 to G9

C4 to A6
16 OASYS PCI
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3. Set the High/Low Velocity parameters so that each Program is active for 
only a specific velocity range.

For instance, setting the Low Velocity to 100 and the High Velocity to 128 will make 
the Program play only when the velocity is fairly high.

When the High/Low Key and Velocity parameters are selected, you can press and 
hold the Shift key to edit the values by playing notes on your MIDI controller.

You can create velocity splits using as many different Programs as you like.

Auditioning Multis through a specific Output Bus
All of Korg’s factory preset Multis are set to use the Analog output as the Master 
Output Bus. If you’d like to audition these Multis through another output, such as 
S/PDIF or ADAT 1-2, you can do so by setting up the Preferences as described 
below.

1. Select Preferences from the Edit menu.

The Preferences window will appear.

2. Select the General tab.

3. Under Multi Defaults, set the Master Output Bus to the desired output.

4. Check the “Reset Master Output Bus When Opening Multis” option.

This will automatically set the Master Output Bus to the default when a Multi is 
opened. Note that this will also edit any custom Multis that you’ve made yourself. 

Reset Master Output Bus can change DSP requirements
If a Multi uses multiple Output Buses, changing the Master Output Bus may 
sometimes require the Programs and Effects to be re-arranged within the DSPs. 
This may either increase or decrease the effective amount of DSP processing power 
available. 

In extreme cases, if the Multi was already using up almost all of the available DSP 
processing power, it is possible that changing the Master bus may put things over 
the edge, making the Multi too big to be played. If this happens, disable the “Reset 
Master Output Bus” option, or take one of the other measures described under 
“Managing Resources” on page 53.

Using the Connect and Disconnect commands
Whenever you add or remove a Program or Effect, copy a Program or Effect 
between channels, add or remove a Patch from a Program, add a new Multisample 
or Sample, or change the Input Type of a Channel, the DSP code running in the 
OASYS PCI is changed. Normally, the OASYS PCI will compute these changes, and 
automatically download the new code and/or Sample data to the DSPs. This 
process may take a few seconds.

If you are making many edits of this sort, such as adding several new Effects or 
Multisamples at once, the Connect and Disconnect commands can speed things up. 
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They allow you to temporarily pause the OASYS PCI, make your edits, and then 
download all of the changes at once. To do this:

1. Select Disconnect from the File menu (command-k).

The OASYS PCI will pause; all Effects and Programs will become silent. If you 
look at the File menu again, you’ll notice that the “Disconnect” command has 
changed to “Connect.”

2. Make the desired changes, such as adding or deleting Effects and 
Programs.

3. Select Connect from the File menu.

The OASYS PCI will start up again, and all of your new changes will be 
downloaded to the DSPs at once.

Saving Multis
Multis store the settings for the entire OASYS PCI, including all mixer settings, all 
Programs and Effects assignments, and all Control Panel settings. 

For instance, let’s say that you’ve created a complex Multi. Several channels have 
Programs, several more are assigned to Streams (for processing tracks from a 
digital audio program), and several others are assigned to Audio Inputs (for 
adding effects to other, external synthesizers). In the course of creating the Multi, 
you’ve edited a few Programs, and edited the Control Panels for a handful of 
Patches and Effects.

All of this, from the Mixer Channel assignments down to the Control Panel edits, 
is stored in the Multi. This means that, in general, the Multi is all that you’ll need 
to save to disk. 

To save a Multi:

1. Make sure that the Mixer, Send Busses, Output Busses, or Channel 
Parameters window is in the foreground.

2. Select the “Save Multi As…” command from the File menu.

3. Name the Multi, and select a location on the disk.

Unlike all other OASYS PCI file types, you can save Multis almost anywhere on 
disk (except in the Korg folders); they do not need to go into a special folder.

For more information on saving files, see“Working With Files” on page 48.

Don’t save into the Korg and Korg FX Programs folders
The Korg and Korg FX Programs folders are reserved for Korg’s own use, so don’t 
save your own sounds in these folders. If you do, the sounds may be deleted when 
you update or re-install the OASYS PCI software.
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Using Programs & Patches
Creating a new Program

To create a new program:

1. In the desired Mixer Channel, set the Input Type to Program.

A new Program, named Untitled, will appear in the Input Slot. All of its parameters 
will be set to default values, and both Patch slots will be empty. 

Editing a Program
To edit a Program:

1. Double-click on the Program name, in either the Mixer Channel input slot 
or the Channel Parameters window.

This opens the Program Edit window, as described on page 80. 

In the Program Edit window, you can select one or two Patches for the Program, 
along with their key and velocity ranges, relative volume levels, scale, voice 
assignment modes, and so on.

Synthesis parameters, such as envelopes, lfos, modulation routings, and so on, are 
edited in the Patch Control Panel, as explained under “Editing a Patch,” below. 

Adding a Patch to a Program
To add a Patch to a Program:

1. Open the Catalog, by selecting it from the Windows menu.

2. In the Catalog, select the Patch tab.

3. Drag a Patch from the Catalog onto a Patch slot in the Program Edit window.

(MacOs only: Alternatively, you can select the Patch slot and then double-click the 
name of the Patch in the Catalog.)

The Patch will appear in the slot. 

Editing a Program Name
You can edit the name of a Program from within a Multi, without needing to save 
the Program to the disk. To edit a Program name:

1. Double-click on the Program name in the Mixer or Channel Parameters 
window.

The Program Edit window will appear.

2. Click in the Program Name parameter, and edit as desired.

The new name will take affect immediately.
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Program edits are stored within the Multi
All edits to a Program, including all parameters in the Program Edit and Patch and 
Effect Control Panel windows, are stored within the Multi. If you are editing a 
Program to use in a specific Multi, there’s no need to save the Program as a 
separate file to disk; just save the Multi, and you’re done. 

This also means that you don’t have to worry about keeping track of which Multis 
use which Programs. Once you add a Program to a Multi, its parameters are 
copied into the Multi, and are separated from the Program file on the disk. Any 
changes to the Program file on disk will not affect existing Multis.

If you like, you can still store the edited Program as a separate file to disk. For 
details, see “Saving Programs,” on page 22.

Editing a Patch
To edit a Patch:

1. Double-click on the Patch name, in the Program Edit window.
or
Command-double-click on the Program name in the Mixer or Channel 
Parameters windows.

The Patch’s Control Panel window will appear.

If you command-double-click on the Program name of a Program with two 
Patches, both Control Panels will appear.

The Control Panel contains all of the parameters for the Patch, such as envelopes, 
lfos, oscillators, filters, drawbars, and so on. The parameters will be different, 
depending on which Patch is being used. 

For a complete description of the Control Panel parameters of a particular Patch, 
please see the separate OASYS PCI Patches and Effects manual, provided in 
Adobe Acrobat (.pdf) format.

Patch edits are stored within the Multi and the Program
All edits to a Patch’s Control Panel are stored within the Program, which is in turn 
stored within the Multi. If you are editing a Patch to use in a specific Multi, there’s 
no need to save the Program as a separate file to disk; just save the Multi, and 
you’re done. 

This also means that you don’t have to worry about keeping track of which 
Programs use which Patches. Once you add a Patch to a Program, its parameters 
are copied into the Program, and are separated from the Patch file on the disk.

Copying Patches between Programs
You can copy a Patch, including its Control Panel settings, from one Program to 
another. Simply use drag-and-drop, or use the Copy and Paste commands in the 
Edit menu.
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Creating splits and layers of Patches within a Program
The two Patches in a Program can be layered together, or split by key and/or 
velocity ranges. Note that Programs can also be split and layered within a Multi, 
which interacts with the Patch key and velocity ranges as shown below.

Cumulative Program and Patch high/low key windows

Layers
To layer Patches in a Program:

1. In the Program Edit window, set the High/Low Key and Velocity parameters 
so that each Patch is active over the entire keyboard and velocity range.

That’s it!

Keyboard splits
To create a keyboard split between two Patches:

1. In the Program Edit window, set the Low Velocity for each Patch to the 
minimum (1), and the High Velocity to the maximum (127).

This will make sure that the Patches both respond to the full velocity range.

2. Set the High/Low Key parameters for each Patch so that each is active for 
only a specific keyboard range.

For instance, setting the Low Key to C4 and the High Key to C8 will make the Patch 
play only in the upper part of the keyboard.

When the High/Low Key and Velocity parameters are selected, you can press and 
hold the Shift key to edit the values by playing notes on your MIDI controller.

Velocity splits
To create a velocity split between two Patches:

Program key window: 

Patch key window: 

Resulting key window: C4 to A6

Patch

Program

ResultC-1 to A6

C4 to G9
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1. In the Program Edit window, set the Low Key for each Patch to the 
minimum (0, or C-1), and the High Key to the maximum (127, or G9).

This will make sure that the Patches both respond to the full keyboard range.

2. In the Program Edit window, set the High/Low Velocity parameters for 
each Patch so that each is active for only a specific velocity range.

For instance, setting the Low Velocity to 100 and the High Velocity to 128 will 
make the Patch play only when the velocity is fairly high.

When the High/Low Key and Velocity parameters are selected, you can press and 
hold the Shift key to edit the values by playing notes on your MIDI controller.

Saving Programs
If you have created a Program that you’d like to use in other Multis, you can save 
the Program as a separate file on disk. Program files store all of the information in 
the Program Edit window, along with any Insert Effects used in the Program’s 
Mixer Channel, and all Control Panel settings for the Program’s Patches and 
Effects.

To save a Program and its Insert Effects:

1. Make sure that the Program Edit window is in the foreground.

2. Select the “Save Program and Insert Effects As…” command from the File 
menu.

3. Name the Program.

4. Select a location to save the Program. 

The OASYS PCI installer creates a folder named “User Files,” with sub-directories 
for Programs and Multis. You can save your own Programs into the Programs 
folder inside this directory (User Files:Programs). You can also create other main 
folders inside the OASYS PCI folder, at the same level as “User Files.”

It’s important to store Programs inside a sub-directory named “Programs.” If a 
Program is not stored in a Program folder inside the OASYS PCI folder, it will not 
appear in the Program Catalog.

For more information on saving files, see“Working With Files” on page 48.

Don’t save into the Korg and Korg FX Programs folders
The Korg and Korg FX Programs folders are reserved for Korg’s own use, so don’t 
save your own sounds in these folders. If you do, the sounds may be deleted when 
you update or re-install the OASYS PCI software.
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Using Effects
Adding Effects to Mixer Channels, Send Busses, and Output Busses

The same set of Effects are available for Mixer Channels, Send Busses, and Output 
Busses. To add an Effect:

1. Open the Catalog, by selecting it from the Windows menu.

2. In the Catalog, select the Effect tab.

3. Drag an Effect from the Catalog onto an Effects slot in the Mixer, Send 
Busses, or Output Busses window.

(MacOs only: Alternatively, you can select the Effect slot and then double-click the 
name of the Effect in the Catalog.)

The Effect will appear in the slot. 

When adding several Effects in a row, you may wish to use the Connect and 
Disconnect commands, as described on page 17.

Loading Effects-Only Programs
Effects-Only Programs store all of the Insert Effects for a Mixer Channel, including 
all Effects Control Panel parameters. You can use them to load chains of Effects into 
a Mixer Channel, or to store such chains for use elsewhere.

Effects-Only Programs are just normal Programs without any Patches loaded into 
the Patch slots. Unlike normal Programs, Effects-Only Programs can be used on 
any type of input, including Audio Inputs, Streams, or even other Programs.

In the Korg factory voicing, they will be placed in the Programs section of the folder 
named “Korg Effects.”

To load an Effects-Only Program:

1. Make sure that FX Auto-Load is enabled on the desired Mixer Channel.

FX Auto-Load must be enabled in order to load an Effects-Only Program.

2. Open the Program Catalog, by selecting it from the Windows menu.

3. Drag an Effects-Only Program from the Catalog onto the Input slot.

(MacOS only: Alternatively, you can select the slot and then double-click the name 
of the Effects-Only Program in the Catalog.)

The Effects-Only Program will replace any previously loaded Insert Effects. 

Note that unlike normal Programs, loading an Effects-Only Program will not 
change the input to the Mixer Channel. If the Channel already contained a 
Program, the original Program’s Patches will play through the new Effects. If the 
Channel’s input was an Audio Input or a Stream, the Input Type will not change, 
and the audio will play through the new Effects. 
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Effects-Only Programs can only be used on Mixer Channels
Effects-Only Programs can only be used on Mixer Channels; they cannot be loaded 
directly into Send Busses or Output Busses.

As a workaround, you can load an Effects-Only Program onto a Mixer Channel, 
and then copy the individual Effects onto the desired Send Bus or Output Bus.

What if I get an error message?
If you try to add an Effect or an Effects-Only Program, but get an error message 
stating that there is not enough processing power to play the Multi, you may need 
to reduce the number of voices of one or more Programs, reduce the number of 
Effects being used, or otherwise free up system resources. For more information, 
please see “Managing Resources,” on page 53.

Using Channel Insert Effects
Channel Insert Effects provide “inline” processing for specific Programs, Audio 
Inputs, or Streams. You can use the inserts for effects such as EQ, distortion, 
compression, in which only the processed signal is heard, or use the Effect’s 
wet/dry parameter for effects such as reverb, for creating a blend of both the 
processed and the original sounds.

FX Auto-Load
Programs can include a set of insert Effects, and the FX Auto-Load button 
determines whether or not these Effects will be loaded into the Mixer. For more 
information, please see “Auto-Load FX controls how Effects are loaded,” on 
page 14

Using Send Effects
Using Effects on a Send Bus enables you to share the Effects between two or more 
Mixer Channels, including any combination of Programs, Audio Inputs, and 
Streams. You can also send a Stream directly to a Send Bus.

Using Mixer Channel Sends
To route a Mixer Channel to a Send Bus:

1. Add one or more Effects to a Send Bus.

2. Select the desired Send Bus from the Send Menu for Send A and/or B.

Each Mixer Channel has two independent mono Sends.

3. Set the Mixer Channel’s Send Level(s) as desired.

4. If necessary, scale the overall input level to the Send using the Send Bus’s 
Send Master Vol parameter.

5. Set the output for the Send Bus as desired.

That’s it!
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Sending a Stream to a Send Bus
To send a Stream to a Send Bus:

1. In your digital audio software, assign one or more audio tracks to a Stream 
output.

Some digital audio software includes a mixer with send busses, and allows the 
send busses to be assigned directly to an output. In this case, you can assign a send 
in the digital audio software to feed directly into an OASYS PCI Stream.

1. In the OASYS PCI Editor, open the Send Busses window, by selecting it 
from the Windows menu.

2. Set the Send Bus’s Stream In parameter to the desired Stream.

The Stream will now be routed to the Send Bus. 

Note that while Mixer Channels can only send mono signals to a Send Bus, Stream 
inputs can be either mono or stereo. Using a stereo Stream input takes up an 
additional physical bus on the DSPs, so you should do this only when you actually 
need a stereo send.

Using Send Busses to conserve DSP resources
If several Channels are using a similar Insert Effect, such as a hall reverb, it may 
make sense for the Channels to share a common reverb via a Send Bus instead. This 
will free up DSP resources, which can then be used in other ways. To set up several 
Channels to share a reverb:

1. Choose the Insert Effect reverb you like best, and use the Edit menu Cut 
command to remove if from the channel.

2. Remove the other Insert Effect reverbs using the Delete key.

This will leave the favorite reverb on the clipboard, ready to paste into the Send 
Bus.

3. Paste the favorite reverb into a Send Bus.

4. Use the Mixer Sends to route the Channels to the Send Bus. Adjust the Send 
levels as desired.

Using Output Bus Effects

Sharing Insert Effects between two or more Channels
You can use Output Busses to process two or more Mixer Channels through the 
same set of Insert Effects. For instance, you might wish to run several drum 
Programs through the same compressor, or apply an overall EQ. To do this:

1. Use the Output parameter to assign the Mixer Channels to the same Output 
Bus.

Unless you want to apply the same Effects to all Mixer Channels, use an Output Bus 
other than the Master Output.
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2. Add the desired Effects to the Output Bus.

3. If you want to hear all of the OASYS PCI sounds through a single stereo 
pair, press the To Master button for the Output Bus.

This will route the Output Bus to the Master output. 

Creating chains of more than four Effects
Output Bus Effects come after the Effects in the Mixer Channels and Send Buses. 
This means that you can use an Output Bus to create a chain of more than four 
Insert or Send Effects. To do this:

1. Create the chain of Effects in the Mixer Channel or Send Bus, as normal.

2. Set the Output of the Mixer Channel or Send Bus to an unused Output Bus.

3. Add more Effects to the Output Bus, as desired.

4. If you want to hear all the OASYS PCI sounds through a single stereo pair, 
press the To Master button for the Output Bus.

This will route the Output Bus to the Master output. 

Using OASYS PCI effects to process other synthesizers or live inputs
You can process other synthesizers, or in fact any other audio source (guitars, 
vocals, etc.), through OASYS PCI effects. In fact, you can process up to 12 live 
inputs simultaneously. To do this:

1. Connect the synthesizer or other audio source to any input(s) on OASYS 
PCI. 

You can use any combination of inputs, ADAT, S/PDIF, or analog.

2. Set an OASYS PCI mixer channel to Audio Input, and select the input to 
which you’ve connected the synthesizer or other audio source.

Repeat for all the audio inputs that you’ll be using.

Once the audio inputs are coming up on the OASYS PCI mixer:

3. Use Insert, Send, and Output Bus effects on the channels, as desired, just as 
you would for internal OASYS PCI synths or audio streams.

For more information on using Insert, Send, and Output Bus effects, see the 
appropriate sections of this chapter, above.

Using OASYS PCI effects to process audio from an audio program
You can route up to 8 channels of audio from a digital audio program to the 
OASYS PCI’s mixer channels, for processing through effects. For more 
information, see “Processing audio through OASYS PCI effects,” on page 44.

Using OASYS PCI effects along with CPU effects (VST, MAS, etc.)
You can use your favorite PowerPC-based effects plug-ins, such as VST or MAS, 
simultaneously with OASYS PCI effects and synthesizers. In general, we 
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recommend that the use of effects should follow the signal flow, with signals 
originating in the CPU, being processed by host-based effects, and then being 
processed through OASYS PCI effects. 

For instance, consider using host-based effects for individual EQ and compression 
on large numbers of recorded audio tracks, and then using the OASYS PCI for send 
effects and special-purpose processing of individual tracks.

Bypassing Effects
You can bypass individual Effects, or bypass all Effects in a channel at once.

To bypass a single Effect:

1. Click on the slot number to the left of the Effect name. 

When bypassed, the Effect name will be grayed out. To re-enable the Effect, just 
click the slot number again. 

You can also bypass Effects by using the Bypass button in the Effect Control Panel.

To bypass all Effects in a Channel, Send, or Output Bus:

1. Option-click (MacOS) or CTRL-click (Windows) on any of the Effects slot 
numbers in the Channel, Send, or Output Bus. 

Editing Effects
To edit an Effect:

1. Double-click on the Effect name, in the Mixer, Send Busses, or Output 
Busses window.

The Effect’s Control Panel window will appear.

The Control Panel contains all of the parameters for the Effect, such as delay times, 
wet/dry mix, and so on. The parameters will be different, depending on which 
Effect is being used. 

For a complete description of the Control Panel parameters of a particular Effect, 
please see the separate OASYS PCI Patches and Effects manual, provided in Adobe 
Acrobat (.pdf) format.

Effect edits are stored within the Multi and the Program
All edits to Effects in the Send Busses and Output Busses, and in Mixer Channels 
with Audio Inputs or Streams as inputs, are stored in the Multi. Edits to a 
Program’s Insert Effects are stored within the Program, which is in turn stored 
within the Multi. As with Programs and Patches, after editing effects, you can 
simply save the Multi, and you’re done. 

This also means that you don’t have to worry about keeping track of which Multis 
and Programs use which Effects. Once you add an Effect to a Multi or Program, its 
parameters are copied into the Multi or Program, and are separated from the Effect 
file on the disk.
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Copying Effects
You can copy Effects, including their Control Panel settings, between Mixer 
Channels, Send Busses, and Output Busses. 

On MacOS, use drag-and-drop to copy the Effect.

On Windows, use drag-and-drop to move an Effect from one slot to another 
(deleting the original instance), or Control-drag to copy the Effect.

On both platforms, you can also use the Copy and Paste commands in the Edit 
menu.

Removing an Effect
To remove an Effect from a Multi:

1. Select the Effect by clicking on its name in the Mixer, Send Busses, or 
Output Busses window.

2. Press the Delete key.

The Effect will be removed from the Multi.

When deleting several Effects in a row, you may wish to use the Connect and 
Disconnect commands, as described on page 17.

No restrictions on connecting stereo and mono Effects
All effects in OASYS PCI are designed so that they can be connected to one 
another. You can connect stereo and mono effects together as you wish, without 
restrictions. (You may still wish to be aware of which effects are stereo and which 
are mono, however, if you wish to maintain a stereo image through a chain of 
effects.)

Also, with a few exceptions (such as EQs and dynamics processors), most mono 
input-mono output effects still pass the true stereo signal in the “dry” side of the 
wet/dry mix. 

Gain and mono input Effects
Mono input effects offer a choice between Left + Right input, or Left input only. If 
L+R is selected, and input gain is not attenuated by at least 6dB, clipping can occur 
(since the left and right signals are added together).

Saving Effects-Only Programs
To save an Effects-Only Program:

1. If the Channel’s Input Type is set to Audio Input or Stream, temporarily 
change the Input Type to Program.

2. Double-click on the Program name in the Input Slot, to open the Program 
Edit window.
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3. Make sure that there are no Patches in the Program. If there are, delete them.

4. Select the “Save Program and Insert Effects As…” command from the File 
menu.

5. Name the Effects-Only Program.

6. Select a location to save the Effects-Only Program. 

The OASYS PCI installer creates a folder named “User Files,” with sub-directories 
for Programs and Multis. You can save your own Programs into the Programs 
folder inside this directory (User Files:Programs). You can also create other main 
folders inside the OASYS PCI folder, at the same level as “User Files.” You may 
wish to distinguish Effects-Only Programs by storing them in a separate main 
folder, separate from standard Programs.

It’s important to store Programs inside a sub-directory named “Programs.” If a 
Program is not stored in a Program folder inside the OASYS PCI folder, it will not 
appear in the Program Catalog.

For more information on saving files, see“Working With Files” on page 48.

7. If you changed the Channel’s Input Type in step 1, change it back again.

Don’t save into the Korg and Korg FX Programs folders
The Korg and Korg FX Programs folders are reserved for Korg’s own use, so don’t 
save your own sounds in these folders. If you do, the sounds may be deleted when 
you update or re-install the OASYS PCI software.
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Using Modulation
Built-in modulation routings

Fixed Modulation Paths
Many Patches and Effects offer built-in modulation paths for certain parameters. 
Sometimes, these modulation paths will be “hard wired,” meaning that the 
amount of modulation can be altered, but the source of the modulation is fixed. 
For instance, a filter envelope might be hard-wired to control the filter cutoff.

Assignable Modulation Paths
Patches and Effects may also offer assignable modulation paths, so that you can 
choose the source of the modulation. Assignable modulation paths include an 
extensive menu of MIDI modulation sources, as detailed under “Modulation 
Sources,” on page 88.

Creating a modulation routing
One of the special features of the OASYS PCI is that all Control Panel parameters 
are modulatable–even if they don’t have built-in modulation routings.

To create a new modulation routing:

1. Click on the name of the Control Panel parameter you’d like to modulate. 
For on/off buttons, option-click (MacOS) or CTRL-click (Windows) on the 
name.

The Modulation Palette will appear. Initially, it will contain two empty modulation 
paths, each with a source and an amount.

2. Select a modulation source from the menu.

For descriptions of the available modulation sources, see “Modulation Sources,” 
on page 88.

3. Set the modulation amount as desired.

The amount is a percentage of the total range of the parameter. When the Amount 
is set to +100, a MIDI modulation value of 127 will take the parameter all the way 
to the maximum value, even if the Control Panel knob or slider is at its very lowest 
setting.

Conversely, when the Amount is set to -100, a MIDI modulation value of 127 will 
take the parameter all the way to the minimum value, even if the Control Panel 
knob or slider is at its very highest setting. 

After you’ve assigned a modulation routing, the name of the Control Panel 
parameter will be underlined and colored red, to show that it is now being 
modulated. 
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You don’t need to do anything to save the new modulation routing; the edits take 
affect immediately.

Modulating on/off parameters
You can control on/off parameters, such as buttons, from any MIDI controller. A 
value of 0 will turn the button off; any value of 1 or greater will turn the button on.

Why don’t the knobs move?
When you modulate parameters using MIDI controllers, you’ll hear the changes, 
but you won’t see the knobs moving. This is normal. If the knob moves, the Patch 
or Effect becomes edited - and you wouldn’t want to edit your sound every time 
you moved the mod wheel.

SysEx Parameter Changes do edit parameters, and the knobs will move 
correspondingly (though you can disable this if you wish). For more information, 
see “SysEx Parameter Change Messages,” below.

Editing an existing modulation routing
To edit an existing modulation routing:

1. Click on the name of the Control Panel parameter. For on/off buttons, 
option-click (MacOS) or CTRL-click (Windows) on the name.

The Modulation Palette will appear, showing the current modulation settings.

2. Edit the modulation sources and/or amounts as desired.

For descriptions of the available modulation sources, see “Modulation Sources,” on 
page 88. You don’t need to do anything to save the edited modulation routing; the 
changes will take affect immediately.

Deleting a modulation routing
To delete a modulation routing:

1. Click on the name of the Control Panel parameter from which you’d like to 
delete the modulation routing. For on/off buttons, option-click (MacOS) or 
CTRL-click (Windows) on the name.

The Modulation Palette will appear.

2. Set the Amount to zero, or set the Source to “None.”

The modulation routing will be deleted.

If both modulation routings are deleted, the underline will disappear from the 
name of the Control Panel parameter, and the color will return to normal.

SysEx Parameter Change Messages
All objects on the Control Panel–knobs, sliders, and so on–can send and receive 
MIDI System Exclusive parameters, for automation with MIDI sequencer 
programs. 
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Enabling SysEx
To enable sending and receiving of System Exclusive parameter messages:

1. Select Preferences from the Edit menu.

The OASYS PCI Preferences window will appear.

2. Press the MIDI/Global tab.

The MIDI/Global parameters will appear.

3. Make sure that the Send MIDI Parameter Change Messages and Receive 
MIDI Parameter Change Messages checkboxes are enabled.

This will enable sending and receiving of the messages.

You can also choose whether or not the Control Panel objects (sliders, knobs, etc.) 
will move in response to received Parameter Change messages. This can be 
convenient for seeing the results of SysEx automation visually, but will add some 
processing overhead. 

SysEx automation will work regardless of whether this parameter is enabled or 
disabled; this controls only the visual display of the automation. Note also that 
only SysEx will cause knobs to move; knobs will not move in response to 
modulation via the Modulation Palette.

4. Set the Update Control Panel from MIDI checkbox as desired.

5. Press the Save button to store the edited preferences.

6. In your MIDI sequencing program, do whatever is necessary to enable 
recording and playback of System Exclusive data.

The OASYS PCI FAQ contains information for some sequencing programs; see the 
program’s manual for more details.

Automating parameters via SysEx
Once SysEx parameter send & receive is enabled, you can now record control 
panel changes (knob movements, menu changes, etc.) into your MIDI sequencer, 
and play them back into the OASYS PCI. To do so:

1. MacOS only: If you are using OMS or FreeMIDI, make sure that the 
OASYS PCI is enabled as a MIDI controller source.

For more information, see the OMS or FreeMIDI documentation.

If you are using Windows, just skip to step 2.

2. Record-enable a track in the MIDI sequencer. 

3. If your program requires you to specify a MIDI source for recording onto a 
track, select the OASYS PCI.

4. Begin recording in the sequencer.

5. Switch to the OASYS PCI Editor.

6. Make the Control Panel changes as the sequence plays. 
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The Control Panel changes will be recorded as SysEx messages in the record-
enabled track.

7. When you are finished, switch back to the sequencer and stop recording.

8. Play back the sequence to hear the recorded automation.

If you have enabled “Update Control Panel from MIDI,” as described above, then 
you will see the Control Panel change as the automation plays.

SysEx Messages are tied to Channel and slot
The System Exclusive messages are tied to the particular Mixer Channel/Send 
Bus/Output Bus and Slot, so that messages from Effect 2 on Channel 3 are separate 
from those of Effect 4 on Channel 7. If you move a Program, Patch, or Effect to a 
new slot or Channel, Send Bus, or Output Bus, previously recorded System 
Exclusive messages will no longer work properly.

Changing the MIDI Channel used by the Mixer Channel, Send Bus, or Output Bus 
will not affect the System Exclusive messages; they will continue to work as they 
did before.

SysEx format
For low-level details on the OASYS PCI System Exclusive format, please see “MIDI 
System Exclusive Format” on page 133.

Mixer parameters have preset modulation routings
All parameters in the Mixer, Send Bus, and Output Busses windows have built-in 
MIDI modulation routings, as shown in the chart below.

Mixer parameter MIDI Controller # Notes

Volume 7

Sets the maximum volume 
of the channel. This is 

modified by Expression, as 
described below.

Width 8

Pan 10
64 is absolute center; 

0 is hard left;
127 is hard right
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Expression 11

Scales channel volume. 
When Expression is set to 
127, channel volume is set 
by the Volume controller 
(#7). When Expression is 

below 127, channel volume 
is reduced.

Mute 89
0 is off (not muted);
1-127 is on (muted)

Solo 90
0 is off (not soloed);
1-127 is on (soloed)

Send Level A 12

Send Level B 13

Send Mute A 91
0 is off (not muted);
1-127 is on (muted)

Send Mute B 93
0 is off (not muted);
1-127 is on (muted)

Send Pre/Post A 92 0 is Post; 1-127 is Pre

Send Pre/Post B 94 0 is Post; 1-127 is Pre

Mixer parameter MIDI Controller # Notes
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Using Samples & Multisamples
Assigning a Multisample to PCM Patch

To change the Multisample assigned to a PCM Patch:

1. Open the Control Panel for the PCM Patch.

2. Drag a Multisample from the Catalog onto the Multisample slot in the 
Control Panel. 

That’s it! The new Multisample will be assigned to the PCM Patch.

NOTE: Only Patches designed to play PCM can use Multisamples. This includes all 
of the Patches in the Korg/Patches/PCM folder, for instance.

Editing a Multisample
To edit a Multisample:

1. Open the Control Panel for the PCM Patch containing the Multisample.

2. Double-click on the name of any Multisample on the Control Panel. 

The Multisample Edit window will open, allowing you to edit the selected 
Multisample.

Within the Multisample Edit window, you can change sample key ranges, add and 
delete samples, and change Patch offset values, such as tuning, decay, volume, pan, 
and filter cutoff.

Multisample edits are stored within the Multi
All edits to a Multisample are stored within the Multi. If you are editing a 
Multisample to use in a specific Multi, there’s no need to save the Multisample as a 
separate file to disk; just save the Multi, and you’re done. 

This also means that you don’t have to worry about keeping track of which Multis 
use which Multisamples. Once you add a Multisample to a Multi, its parameters 
are copied into the Multi, and are separated from the Multisample file on the disk. 
Any changes to the Multisample file on disk will not affect existing Multis.

If you like, you can still store the edited Multisample as a separate file to disk. For 
details, see “Using the Zoom In and Zoom Out buttons,” on page 40.

Selecting a Key Range
To select a Key Range in the Multisample Edit window, you can do one of three 
things:

1. Click in the Key Range’s box above the keyboard graphic.
or
Click on a note on the keyboard graphic.
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or
Play a note on a MIDI controller.

When selected, the parameters of the selected Key Range’s are shown at the top of 
the window. The Key Range’s box and the range on the keyboard are both 
hilighted in light blue, and the base key is shown in red.

NOTE: For more information on MIDI input in the Multisample Edit window, see 
“MIDI must be on the correct channel, within all key and velocity windows” on 
page 37.

Deleting a Key Range
To delete a Key Range in the Multisample Edit window:

1. Select the Key Range that you’d like to delete.

2. Press the Delete key.
or
Select the Cut command.
or
Select the Clear command.

When a Key Range is deleted, the next highest Key Range is adjusted downwards 
to fill the gap.

Changing the High, Low, and Base keys
You can change a Key Range’s High, Low, and Base keys in three ways: edit the 
numeric fields at the top of the window, drag the edges of the box above the 
keyboard graphic, or use your MIDI controller. 

Numeric editing
To change the High, Low, or Base Key numerically, simply edit the desired 
parameter at the top of the Multisample Edit window.

When selected, the High, Low, and Base Key parameters also respond to MIDI 
input.

Graphic editing
To change the High and Low Keys graphically:

1. Move the cursor over the edge of a Key Range.

2. When the cursor changes to a double-arrow shape, click and drag the edges 
of the Key Range as desired.

To change the Base Key graphically:

1. Click on the Base Key (shown in red) on the graphic keyboard.

2. While holding down the mouse button, drag the key to a new location on 
the keyboard.

3. Release the mouse button to assign the new Base Key.
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MIDI editing
To edit the High Key via MIDI:

1. Hold down the command key (MacOS) or shift-left-bracket “[” (Windows) 
on your computer keyboard.

Notice that the High Key parameter becomes selected.

2. While holding the key(s) on your computer keyboard, play a note on your 
MIDI controller.

To edit the Low Key via MIDI:

1. Hold down the option key (MacOS) or shift-right-bracket “]” (Windows) on 
your computer keyboard.

Notice that the Low Key parameter becomes selected.

2. While holding the key(s) on your computer keyboard, play a note on your 
MIDI controller.

To edit the Base Key via MIDI:

1. Hold down both the option and command keys (MacOS) or shift-backslash 
“\” (Windows) on your computer keyboard.

Notice that the Base Key parameter becomes selected.

2. While holding the keys on your computer keyboard, play a note on your 
MIDI controller.

MIDI must be on the correct channel, within all key and velocity 
windows
When the Multisample Edit window is in the foreground, incoming MIDI selects 
the current Key Range, and can also edit various parameters, as described below.

The Mixer channel’s MIDI channel assignment, and all Multi and Program key and 
velocity windows, all apply to MIDI received in this window. If incoming MIDI 
data is on the wrong channel, or is outside of the key and velocity windows, then it 
will have no effect. 

As a rule of thumb: if incoming MIDI will play the Patch containing the 
Multisample, then it will also be received for selection and editing in the Edit 
Multisample window.

Edit Multisample window must have focus (Windows only)
On Windows computers, the Edit Multisample window must have the focus in 
order to respond to MIDI input. To set the focus to the window, simply click on it.

Assigning a Sample to a new Key Range
To add a Sample and create a new Key Range containing the Sample:

1. Drag the Sample from the Catalog onto the keyboard graphic. 
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Keys hilight as you drag over them;

2. Once the Sample is over the desired key, release the mouse button.

The Sample will be assigned to the selected key.

Dragging a Sample to the middle of an existing Key Range
Dragging to the middle of an existing range splits the Key Range at the insertion 
point, with the new sample assigned to the top part.

For instance, let’s say that range A spans C2 to C4. The user Cmd-Drags a sample 
over G2 to G3. The result: range A now spans C2 to F#2; the new user-created 
range B spans G2 to G3; and a second new range C, using the same parameters as 
the original range A, spans G#3 to C4.

Changing the Sample assigned to a Key Range
To change the Sample assigned to a Key Range:

1. Select the Key range. 

2. Drag a new Sample from the Catalog into the Sample parameter at the top 
of the window. 

(MacOS Only: Alternatively, you can select the Sample slot and then double-click 
the name of the Sample in the Catalog.)

For more information on using the Catalog, please see the section titled “Catalog” 
on page 102.

The new Sample will now be assigned to the Key Range. All other parameters in 
the Key Range will remain unchanged.

Importing AIFF, WAV, and Sound Designer II Samples
OASYS PCI can use 16-bit and 24-bit samples in a number of different formats, 
including AIFF, WAV, and Korg’s proprietary .kes format. Additionally, Sound 
Designer II format samples are supported on MacOS only.

To use your own AIFF, WAV, or Sound Designer II samples with OASYS PCI:

1. In the OASYS PCI Folder, create the directory structure that you’d like to 
use. 

For instance, create a Samples folder within the User Files folder. Then, within the 
Samples folder, create folders to organize your samples, such as Drums, Synths, 
Effects, etc.

This is important, since once you start creating Multisamples from the Samples, 
they must remain in the same folder, or the Multisamples won’t be able to find 
them.

2. Copy the samples into the folders you’ve just created.

3. In the OASYS PCI Editor, close and re-open the Catalog window.
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The new Samples will appear in the Catalog under the Samples tab. You can now 
use them in Multisamples just as you would the Korg factory samples.

Stereo Samples
OASYS PCI supports both split and interleaved stereo samples. Split stereo samples 
must have file names ending in -l (left) and -r (right), before the 3-character file 
extension. For instance, a split stereo WAV-format bass sample would be named 
“bass-r.wav” and “bass-l.wav.”

Split stereo files appear in the Catalog as a single stereo sample.

Editing Samples in an external editor
You can use the Open Sample in Editor button to edit any WAV, AIFF, or Sound 
Designer II Sample in your preferred external sample editing program, such as 
Peak, WaveLab, SoundForge, Spark, Alchemy, etc. 

Selecting a sample editing program
First, you need to select a sample editing program:

1. Select Preferences from the File menu.

The Preferences window will open.

2. Select the PCM Playback tab.

3. Under Sample Editor, press the Choose button.

A standard file-select dialog will appear.

4. Select your preferred sample editing program.

When the file-select dialog is closed, the sample editor’s name will now appear in 
the Preferences window.

Editing a Sample
To edit a Sample in the selected sample editing program: 

1. In the Multisample Edit window, select the Sample to edit. 

2. Press the Open Sample in Editor button. 

The Sample will be opened in the sample editing program.

3. Edit the Sample as desired.

4. Save your edits in the sample editing program.

5. Switch back to the OASYS PCI Editor.

6. In the Multisample Edit window, make sure that the same Sample is still 
selected, and then press the Re-Load Sample button.

The edited Sample will be loaded into OASYS PCI.
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Korg factory “.kes” samples cannot be edited
Note that Korg’s proprietary .kes sample files are encrypted, and so they cannot be 
opened in external editors.

Editing using the Show Parameter menu and on-screen sliders
You can choose one parameter, such as volume or pan, to be displayed for all of 
the ranges simultaneously. The value is shown as a slider within each Key Range 
box, allowing you to see the settings for all Key Ranges at once.

To select the parameter being displayed, use the Show Parameter menu. The 
selections include most of the numeric edit fields at the top of the window: 
Volume, Pan, Cutoff, Tune, Decay, and Exclusive Group. A final setting, None, 
makes the sliders disappear, for easier viewing of the sample names.

To edit the parameter for a specific range, just move the on-screen slider. The value 
is shown within the slider handle. To edit the value numerically (using keypad, 
inc/dec etc.), use the normal edit fields at the top of the window.

Sliders are drawn on top of sample names. If you need to have an unobstructed 
view of all of the names, choose “None” from the Show Parameter menu to 
temporarily hide the sliders.

Multisample parameters are offsets to Patch values
All of the parameters are offsets from a default value in the Patch, with a range of 
+/- 100. The default of “+00” is shown as a thin, lightly colored line across the 
center of the graphic. 

Note that the Multisample does not actually contain filtering, panning, and so on; 
these offsets depend on the Patch to support these functions. Some Patches may 
not support all of the parameters seen here.

Exclusive Groups
Exclusive Groups allow you to group Key Ranges so that one Sample will cut off 
any other Sample in the group. For instance, you can use this so that a closed hi-
hat Sample cuts off the sound of an open hi-hat.

There are 63 Exclusive Groups, plus two special settings, Off and Silent. The Off 
setting means that the Key Range is unaffected by the other Exclusive Groups. The 
Silent setting allows you to set a Key Range so that it makes no sound, and uses no 
voices of polyphony. For more information, see “Exclusive Group” on page 96.

Using the Zoom In and Zoom Out buttons
The zoom buttons allow you to change the size of the keyboard graphic. 

Use the small keyboard to show a large keyboard range at one time, to get an 
overview of the entire Multisample.

Use the large keyboard when editing Multisamples with small keyboard ranges, 
such as drum kits.
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Saving Multisamples
If you have created a Multisample that you’d like to use in other Multis, you can 
save the Multisample as a separate file on disk. Multisample files store all of the 
information in the Multisample Edit window, including links to the Samples used 
by the Multisample (but not the Samples themselves).

To save a Multisample:

1. Make sure that the Multisample Edit window is in the foreground.

2. Select the “Save Multisample As…” command from the File menu.

3. Name the Multisample.

4. Select a location to save the Multisample. 

The OASYS PCI installer creates a folder named “User Files,” with sub-directories 
for Programs, Multis, and Multisamples. You can save your own Multisamples into 
the Multisamples folder inside this directory (User Files:Multisamples). You can 
also create other main folders inside the OASYS PCI folder, at the same level as 
“User Files.”

It’s important to store Multisamples inside a sub-directory named “Multisamples.” 
If a Multisample is not stored in a Multisample folder inside the OASYS PCI folder, 
it will not appear in the Multisample Catalog.

For more information on saving files, see“Working With Files” on page 48.

Don’t save into the Korg and Korg FX Programs folders
The Korg and Korg FX Programs folders are reserved for Korg’s own use, so don’t 
save your own sounds in these folders. If you do, the sounds may be deleted when 
you update or re-install the OASYS PCI software.

OASYS PCI and Sample RAM
Each of the four effects/synths DSP chips has 6 MB of DRAM, used for samples 
and long delays. The samples for a single Patch must fit within the 6MB of DRAM 
belonging to a single DSP chip. Multiple Patches may use the DRAM on a single 
DSP, but samples for a single Patch cannot span across the RAM of multiple DSPs.

So, you can use four Patches, each with its own 6 MB of samples– but you can't use 
a single Patch with 24 MB of samples.

OASYS PCI supports 24-bit samples, allowing very high fidelity. This also means 
that the RAM hardware is designed for 24-bit sample words, as opposed to the 16-
bit words common on most samplers. So, a sample which would take up 4 MB on a 
16-bit sampler will take up 6 MB on the 24-bit OASYS PCI. 
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Using Audio Programs
The OASYS PCI is designed for seamless use with all MacOS and Windows ASIO-
or MME-compatible digital audio programs, such as Acid, Cakewalk Pro Audio 
and Cakewalk Metro, Cool Edit Pro, Cubase VST, Digital Performer, Logic Audio, 
Peak, SAW, Sound Forge, Spark, Studio Vision Pro, and Vision DSP. OASYS PCI 
also supports two-channel audio I/O via the Apple Sound Manager.

For details on specific programs, see the OASYS PCI FAQ
Please see the OASYS PCI FAQ for details on setting up and using OASYS PCI 
with specific audio programs. These instructions include important information, 
so if you have not already read them, please do so before proceeding!

Basic concepts
OASYS PCI works with audio and MIDI programs in three ways: as audio I/O 
hardware, as a synthesizer, and as an effects processor.

As an audio I/O card, OASYS PCI provides audio software with 12 hardware 
inputs and outputs, plus eight additional “stream” outputs to OASYS PCI effects. 
Within audio software, “stream” outputs act just like regular outputs.

As a synthesizer, OASYS PCI appears to MIDI programs like an external, rack-
mount synth with 32 MIDI inputs (two 16-channel MIDI devices) and a dedicated 
MIDI interface. So, instead of needing to send MIDI data to a port on an external 
interface, you just assign it to OASYS PCI A or B. Due to its integration with audio 
I/O hardware, you can also record OASYS PCI directly via ASIO or MME, without 
any external connections.

As an effects processor, OASYS PCI appears to audio/MIDI programs as a rack of 
external effects, hooked up to physical audio inputs and outputs. It interacts with 
the audio/MIDI program just as those external effects would, using audio inputs, 
audio outputs, sends, and busses. As with OASYS PCI synths, the integration with 
audio I/O hardware means that all connections to the effects can be made directly 
via ASIO or MME, without need for any external connections.

Setting the sample rate and word clock source

Set the sample rate within the audio program
Some audio programs may allow you to freely switch between different sample 
rates; others may require you to choose a sample rate when creating a file, after 
which the rate is fixed. 

Whenever an audio program is running, be sure to set the sample rate from within 
the audio program, as opposed to using the OASYS PCI Editor preferences 
settings. Otherwise, the audio program may not know that the sample rate has 
changed.
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The OASYS PCI Editor’s settings will reflect the sample rate settings made within 
the digital audio program.

Word clock source and ASIO programs
When using ASIO-compatible audio programs, set the word clock source from 
within the audio program. When using an external clock source, make sure that the 
sample rate of the source matches the rate set in the digital audio program.

Word clock source and Windows MME audio programs
When using Windows MME programs, you must set the word clock source using 
the OASYS PCI Wave Device Settings program (as described on page 123). When 
using an external clock source, make sure that the sample rate of the source 
matches the rate set in the digital audio program.

Synchronization settings (Windows)
Each of the OASYS PCI’s stereo pairs of inputs and outputs appear to Windows 
MME audio programs as an independent wave device. When the Auto Sync button 
is turned on in the OASYS PCI Wave Device Settings program, all of the wave 
devices will be grouped together so that they operate as a single, synchronized 
multichannel I/O device. 

Auto Sync is an easy-to-use, fool-proof mode optimized for working with 
multichannel audio programs. However, you can also use multiple audio programs 
at once, each connected to different sets of stereo I/O pairs. In this case, you should 
use the Custom Synchronization settings instead. For more information, see 
“Custom Synchronization” on page 128.

Output selection
With any ASIO- or MME-compatible mutichannel audio program, you can process 
up to 8 channels of audio through the OASYS PCI’s mixer channels and effects send 
busses, and route an additional 12 channels directly to the OASYS PCI’s outputs.

From this perspective, you can think of the OASYS PCI as a combination of a 12-
channel I/O card and an 8-input multieffect processor.

When the OASYS PCI is used as an audio device, you will see the following 
selections in the audio program’s output menu: Analog L-R, S/PDIF L-R, ADAT 1-
2, ADAT 3-4, ADAT 5-6, ADAT 7-8, and Streams 1-8.

Analog L-R, S/PDIF L-R, ADAT 1-2, ADAT 3-4, ADAT 5-6, and 
ADAT 7-8
These selections allow you to route audio directly to the OASYS PCI outputs, 
without passing through the mixer. For more information, see “Routing audio 
directly to the OASYS PCI outputs,” below.
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Streams 1-8
Streams 1-8 allow you to route the signal into an OASYS PCI mixer channel or 
send bus. For more information, see “Processing audio through OASYS PCI 
effects” and “Routing audio to an OASYS PCI Send Bus,” below.

Processing audio through OASYS PCI effects
You can route up to 8 channels of audio from the digital audio program to the 
OASYS PCI’s mixer channels, for processing through effects. To do this:

1. In the audio program, assign the audio channel’s output to a Stream (1-8).

The OASYS PCI’s mixer channels will accept either stereo or mono signals. If the 
digital audio program offers only stereo outputs, use hard-panning to send 
discrete, mono signals to separate OASYS PCI mixer channels.

2. In the OASYS PCI Editor, set the mixer channel’s Input Type to Stream.

3. Set the mixer channel’s input to the Stream you selected in Step 1.

The audio will now be routed to the OASYS PCI mixer channel.

4. Use Insert, Send, and Output Bus effects on the channels, as desired, just as 
you would for internal OASYS PCI synths or audio inputs.

You can also send audio directly to an OASYS PCI Send Bus, as described below.

Finally, you can record the processed audio back into your audio program, as 
described in “Recording OASYS PCI synthesizers and effects,” below.

Routing audio to an OASYS PCI Send Bus
You can route up to 4 channels of audio from the digital audio program to the 
OASYS PCI’s Send Busses. The audio will be merged into the Send Bus along with 
any audio sent from OASYS PCI Mixer Channels. Using this feature, OASYS PCI 
Mixer Channels can share send effects with the audio program.

To do this:

1. In the audio program, assign the audio channel or send bus’s output to a 
Stream (1-8).

Many programs allow audio channels to “send” directly to an output. In this case, 
just set the channel to send to the desired Stream.

2. In the OASYS PCI Editor’s Send Busses window, set the Send Bus’s input 
to the Stream you selected in Step 1.

The audio channel will now be routed to the OASYS PCI Send Bus.

Routing audio directly to the OASYS PCI outputs
You can route up to 12 channels of audio from the digital audio program directly 
to the OASYS PCI’s outputs, without passing through the OASYS PCI mixer. To do 
this:
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1. In the audio program, assign the audio channel’s output to an output: 
Analog L-R, S/PDIF L-R, ADAT 1-2, ADAT 3-4, ADAT 5-6, and ADAT 7-8.

That’s it!

If the digital audio program offers only stereo outputs, you can still use hard-
panning to send discrete, mono signals.

Different routing options
Since OASYS PCI and most digital audio programs all offer a large degree of 
flexibility in signal routing, you can use channel effects either as in-line inserts, or 
as sends from a digital audio program or external mixer.

For instance, you can route a hard-disk track directly to an OASYS PCI mixer 
channel, for individual insert processing.

Or, you can create an output bus in the digital audio program, and route several 
tracks at once through an OASYS PCI mixer channel, for group insert processing 
(like an output bus).

Finally, you can create a send bus in the digital audio program, and route that send 
bus to an OASYS PCI mixer channel, or to an OASYS PCI send bus. In either case, 
the dry signal from the digital audio can then be routed completely separately from 
the OASYS PCI effects processing.

Recording directly from the OASYS PCI inputs
The OASYS PCI feature a total of 12 audio inputs - stereo analog, stereo S/PDIF, 
and 8-channel ADAT optical. With compatible multitrack audio software, you can 
record from all of the inputs simultaneously. 

To record from the audio inputs:

1. From the digital audio program, open the OASYS PCI ASIO control 
panel/Audio Settings window.

For information on how to open the ASIO control panel, please see “ASIO Control 
Panel/ Audio Settings,” on page 117.

2. Under Record Source, select Audio Inputs.

3. Press OK to close the window.

The audio inputs will now be routed to the audio program’s inputs.

4. In the digital audio program, select the desired inputs and record as usual.

Recording OASYS PCI synthesizers and effects
In addition to recording from the audio inputs, you can also record the output of the 
OASYS PCI mixer directly into the digital audio program. This means that, without 
making any external connections, you can:

• Record OASYS PCI synthesizers
• Record live audio inputs, processed through OASYS PCI effects
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• Send audio from your audio/MIDI program (using Streams), process the 
audio through OASYS PCI effects, and record the processed audio back into 
your audio program

The OASYS PCI mixer outputs are routed to the corresponding audio inputs, so 
that mixer output ADAT 3-4 is heard at audio input ADAT 3-4, and so on.

You can even simultaneously record dry audio inputs along with processed audio 
and synthesizers, simply by assigning the desired audio inputs to OASYS PCI 
mixer channels.

To record the output of the OASYS PCI mixer into a digital audio program:

1. From the digital audio program, open the OASYS PCI ASIO control 
panel/Audio Settings window.

For information on how to open the ASIO control panel, please see “ASIO Control 
Panel/ Audio Settings,” on page 117.

2. Under Record Source, select Mixer Outputs.

3. Press OK to close the window.

The mixer outputs will now be routed to the audio program’s inputs.

4. In the digital audio program, select the desired inputs and record as usual.

Zero-latency record monitoring
The OASYS PCI include a built-in, zero-latency monitor mixer, so that you can 
listen to inputs during recording without any audio delay. You can adjust the 
volume level for each input, and route each input to any output.

These output routing and volume settings affect only the monitor mixer; they do 
not have any affect on audio recorded into or played back from the digital audio 
program.

The monitor mixer is always active. When you don’t need to monitor inputs, you 
can mute individual channels, or mute the entire mixer at once. 

Programs which support ASIO 2.0 can automatically control the monitor mixer’s 
levels and output routings, matching the volume and output settings of record-
enabled tracks. For more information on how this works with a specific ASIO 2.0-
compliant audio program, please see the OASYS PCI FAQ.

Note that you can also use the main mixer to set up effects for monitoring, such as 
reverb on a vocal. For more information, see “Record monitoring with effects,” 
below.

To access the monitor mixer settings:

1. From the digital audio program, open the OASYS PCI ASIO control 
panel/Audio Settings window.

For information on how to open the ASIO control panel, please see “ASIO Control 
Panel/ Audio Settings,” on page 117.

The monitor mixer controls are on the left side of the control panel.
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2. Set the volume level and output assignment for each input, as desired. 

Multiple inputs can be routed to the same output, if desired.

3. To mute a channel, turn its volume all the way down (-144dB).

4. To mute all inputs at once, press the Mute All button.

5. When you’re finished, press OK to close the window.

The settings will automatically be saved to the OASYS PCI Preferences file, so they 
are maintained until you change them again. The settings are shared between all 
audio programs.

6. In the digital audio program, disable software-based record monitoring. 

Most digital audio programs also have software-based record monitoring. If you 
are using the OASYS PCI’s monitor mixer, you should disable the program’s 
software-based monitoring. Consult the program’s manual for details.

Record monitoring with effects
Using the OASYS PCI’s main mixer, you can record from the audio inputs and 
monitor through effects, all with zero latency. For instance, you can record vocals, 
and send the vocals to a reverb to enhance the singer’s headphone mix–but record 
only the dry vocal sound.

To do this:

1. In the OASYS PCI ASIO control panel/Audio Settings window, press the 
Mute All button to mute the monitor mixer.

2. Also in the ASIO control panel/Audio Settings window, under Record 
Source, select Audio Inputs.

3. When you’re finished, press OK to close the window.

Now, you’ll set up the monitor path using the OASYS PCI mixer.

4. Assign the input to a channel in the OASYS PCI mixer.

5. Set up any desired insert or send effects.

Since the audio program is recording directly from the audio inputs, these effects 
will only be heard in the monitor path. If you prefer, of course, you can also record 
the effects, as described under “Recording OASYS PCI synthesizers and effects,” on 
page 45.
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Working With Files
File Types

OASYS PCI uses seven different types of files: Multis, Programs, Patches, Effects, 
Samples, Multisamples, and Scales.

Multis contain an entire setup for the OASYS PCI, including all Mixer, Send Bus, 
and Output Bus settings, links to all selected Programs and Effects, and all Patch 
and Effects Control Panel settings. (Control Panel settings can also be stored in 
Programs, if desired.) Multis have the file suffix “oam.”

Programs are the basic sounds of the OASYS PCI, and must be placed on a Multi 
Channel to be played. They play one or two Patches, which can be layered or split 
by key and velocity ranges. They also have up to four Insert Effects, which appear 
in the Mixer Channel. Programs store all Control Panel settings for their Patches 
and Effects. Programs have the file suffix “oap.”

Patches are the basic units of sound creation on the OASYS PCI. They must be 
placed in a Program in order to be played. Each Patch contains its own synthesis 
algorithm, which may be quite different from one Patch to another. Patches have 
the file suffix “oas.”

Effects are used to modify the sound of Patches, Audio Inputs, or Streams. They 
can be used as insert effects in the Mixer Channels and Output Busses, or as send 
effects via the Send Busses. Each Effect contains its own audio processing 
algorithm, which may be quite different from one Effect to another. Effects have 
the file suffix “oae.”

Samples are audio files, which can be placed in a Multisample (see below) and 
then played back by sample-based OASYS PCI Patches. OASYS PCI recognizes 
mono and stereo 16-bit and 24-bit samples in a number of different formats, 
including AIFF, WAV, and Korg’s proprietary .kes (mono) and .k2s (stereo) 
formats. Additionally, Sound Designer II samples are supported on MacOS only.

Multisamples are collections of one or more Samples assigned to ranges across the 
keyboard. Each key range has offsets for common parameters, such as volume, 
pan, filter cutoff, decay, and so on, which can be used to adjust Patch parameters 
individually for each Sample. Mono Multisamples have the file suffix “kem,” and 
stereo Multisamples have the suffix “k2m.”

Scales control how MIDI note numbers affect the pitch of a sound. Any MIDI note 
number can be set to create the pitch of any other note, with both coarse and fine 
tuning. Each Patch in a Program can be set to use a different Scale, if desired. 
Scales are simply text files, so they’re easy to create and edit. See “Scales,” on 
page 131 for more information.
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Adding a new set of Korg or third-party sounds
The directory structure makes it really simple to add a new set of sounds and 
effects from Korg or third-party sound developers. Each set of sounds contains its 
own sub-folders for Multis, Programs, Patches, Effects, Multisamples, and Samples, 
so all items appear automatically in the Catalog window.

To add a new set of sounds:

1. Drag the main folder into the OASYS PCI folder.

2. If you are running the OASYS PCI Editor, close and re-open the Catalog 
window.

That’s it! All the new sounds and effects will now be available.

Saving your own sounds

To begin, save into the User Files folder
The OASYS PCI installer creates a folder named “User Files,” with sub-directories 
for Programs and Multis. Save your own sounds into this directory, with Programs 
in the Programs folder, Multis in the Multis folder, and Multisamples in the 
Multisamples folder. 

IMPORTANT: If you plan to distribute your sounds, you might want to change the 
name of the User Files folder to something more specific, such as “Sarah’s Sounds.” 
This will save you a little work later on.

Use folders and sub-directories to organize your sounds
You can create sub-directories within the Programs and Multis folders, to further 
organize your sounds; just keep to one level of directories underneath the main 
Programs or Multis folders. 

You can also create any number of additional main folders of your own, at the same 
level as the User Files folder, with their own Programs and Multis folders.

Don’t save into the Korg and Korg FX Programs folders
The Korg and Korg FX Programs folders are reserved for Korg’s own use, so don’t 
save your own sounds in these folders. If you do, the sounds may be deleted when 
you update or re-install the OASYS PCI software.

Distributing sounds
If you plan to distribute your sounds to other OASYS PCI users, you should use 
one or more folders with custom names, such as “John Smith Analog Collection,” 
instead of User Files. This will allow OASYS PCI users to install your sounds by 
simply dragging your main folder into the OASYS PCI Folder. 

Make sure to create the standard Multis, Programs, and Multisamples folders 
within the main folder. These folders are necessary for the sounds to show up in the 
Catalog. Also, when you distribute the sounds, this means that other OASYS PCI 
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users can add the sounds simply by dragging the main folder (e.g. “John Smith 
Analog Collection”) into the OASYS PCI folder.

Cross-platform considerations
All OASYS PCI files can be used on both MacOS and Windows computers, as long 
as you are careful to observe the following:

Naming conventions. Make sure that your file names don’t exceed 27 characters, 
do include three-character extensions, and don’t include forbidden characters. For 
more information, see “File Names,” below.

File type and creator. If OASYS PCI files created using Windows are transferred to 
a MacOS computer, you won’t immediately be able to use them with OASYS PCI. 
This is because the MacOS marks files with a “type” and “creator,” which 
determines which programs can open the file. Files created on Windows do not 
have this information, so the MacOS doesn’t know what programs can use the 
files.

To fix this, just drag the files or (folders of files) onto the OASYS Windows-MacOS 
Autotyper program. This program will automatically set the type and creator for 
Programs, Multis, and Multisamples, based on the three-character file extension 
(.oap, .oam, and .kem or .k2m, respectively).

File type and creator are transparent to Windows, which uses three-letter name 
extensions instead. If you are distributing sounds created on Windows, you might 
consider using a MacOS computer to run the files through the autotyper program; 
this will ensure that the files can be opened by both MacOS and Windows users, 
without any additional work on their part.

Sound Designer II format is MacOS only. The Sound Designer II sample format 
includes a MacOS-specific file characteristic called a “resource fork,” which makes 
the files incompatible with Windows. If you have samples in this format which 
you’d like to distribute within OASYS PCI Multisamples, convert them to AIFF or 
WAV format first.

File Names
To ensure compatibility with OASYS PCI users on all computing platforms, you 
need to observe a few file name conventions.

Restricted characters
Be careful not to use the following characters in any file names:

\/:*?"<>.

These characters will work fine on MacOS computers, but will not work on 
Windows systems.
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File name length
Be careful to keep file names under 27 characters, for a total of 31 characters 
including the “dot” and 3-letter file extension. Longer file names will work fine on 
Windows computers, but not on MacOS.

File extensions
All OASYS PCI files have special three-letter file extensions–.oam for Multis, .oap 
for Programs, .kem for Multisamples, and so on. These are not critical for use on 
MacOS, which has its own ways of determining file type, but they are very 
important for Windows. 

If you want the Multis, Programs, and Multisamples you create to work on all 
platforms, make sure that the names include the appropriate file extension.

File and folder organization
All OASYS PCI files, except for Multis, must be stored inside the OASYS PCI folder. 
(Multis may be stored anywhere on disk, including the OASYS PCI folder if 
desired.) Within the main OASYS PCI folder are folders for sound libraries, such as 
the Korg factory sounds and optional sound packages from Korg and third parties, 
or user projects, such as “TV Series Third Season Cues.”

Within each of these project or library folders are five sub-folders, one each for 
Programs, Patches, Effects, Samples, and Multisamples. There should always be 
these five folders at this level. You can also store Multis here, if you like. 

As shown below, the Korg folder also contains two special folders, Mixer and 
Scales. These are only used within the Korg folder.

It is very important that Patches be stored within the Patches folder, Effects within 
the Effects folder, and so on. Files must be stored in the appropriate folders in order 
for them to appear in the Catalog window. 

Within each of these sub-folders can be one additional layer of folders. These 
additional folders can be used to create sound categories, such as bass, piano, pad, 
reverb, delay, and so on.
OASYS PCI 51



Working With Files Using the OASYS PCI

E
ng

lis
h

File and folder organization
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Managing Resources
The OASYS PCI provides a large amount of DSP processing power. However, as 
with all things in the world, that power is finite. Here are some hints to help you to 
optimize the system’s resources.

Sample rate affects processing power
The sample rate affects the processing power available to the OASYS PCI. You’ll get 
about 8% more processing power for synthesizers and/or effects at 44.1kHz than at 
48kHz.

Number of Voices
The OASYS PCI uses fixed voice allocation, which means that if you want to play 
six-note chords on an electric piano sound, you must tell the system to reserve six 
voices for that Program. This is done through the Patch’s Number of Voices 
parameter, in the Edit Program window. 

You should try to set the number of voices just as high as necessary, and no higher. 
The fewer voices you reserve for one Patch, the more that will be available for other 
Patches, or for Effects.

Use Send and Output Busses to share Effects
Each Mixer Channel can have its own Insert Effects, which allows for very 
powerful and flexible sound-shaping. However, if several Channels each use a 
number of resource-hungry Effects, this can eat up DSP resources pretty quickly. 

If several Channels are using similar Insert Effects, it may make sense for them to 
share the effects through a Send Bus or Output Bus instead. This will free up DSP 
resources, which can then be used in other ways. 

For more information, see “Using Send Busses to conserve DSP resources,” on 
page 25, and “Sharing Insert Effects between two or more Channels,” on page 25.

Optimizing physical bus usage
The OASYS PCI s a certain number of physical busses, used to communicate 
between the DSP chips on the card. These physical busses are used to create the 
Mixer Channels, Send Busses, and Output Busses. 

The Detailed view of the Resource monitor (see page 100) shows how many of the 
physical busses are in use. You can turn off Mixer Channels and Send Busses to 
optimize the use of these physical busses.

Turn off unused Mixer Channels
If a Mixer Channel’s Input Type is set to “Off,” or if the Output and Sends are all set 
to “Off,” the Channel will be turned off, and will not use a physical bus.
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Turn off unused Send Busses
If the Send Bus Output is set to “Off,” or if no Mixer Channels are assigned to a 
Send Bus and the Send Bus’s Stream Input is set to “None,” the Send Bus will be 
turned off, and will not use a physical bus.

Output Bus “To Master” can change DSP processing requirements
Activating an Output Bus’s To Master function may sometimes require the 
Programs and Effects to be re-arranged within the DSPs. This may either increase 
or decrease the effective amount of DSP processing power available. In extreme 
cases, if a Multi was already using up almost all of the available DSP processing 
power, this may put the processing requirements over the edge, so that the Multi is 
too big to be played. 

If this happen, you can reduce the number of Output Busses routed to the Master 
output, or use other methods described in this section to reduce the DSP 
processing load.

MIDI Parameter Changes and Control Panel objects
On-screen Control Panel objects (sliders, knobs, etc.) can be configured to move in 
response to received MIDI System Exclusive Parameter Change messages. This is a 
convenient feature, but whenever a knob moves, it adds a small amount of 
processing overhead to the host CPU. 

If you wish to optimize host CPU processor usage, you can disable this feature. To 
do so:

1. Select Preferences from the Edit menu.

The OASYS PCI Preferences window will appear.

2. Press the MIDI/Global tab.

The MIDI/Global parameters will appear.

3. Turn off the Update Control Panel from MIDI checkbox.

4. Press the Save button to store the edited preferences.

Disable System Exclusive messages, if not in use
Sending and receiving MIDI System Exclusive Parameter Change messages takes 
a small amount of CPU processing power. If you don’t need this feature, you can 
disable these messages completely. To do so:

1. Select Preferences from the Edit menu.

The OASYS PCI Preferences window will appear.

2. Press the MIDI/Global tab.

The MIDI/Global parameters will appear.

3. Turn off the Send MIDI Parameter Change Messages and Receive MIDI 
Parameter Change Messages checkboxes.
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4. Press the Save button to store the edited preferences.

Close unnecessary windows
Mixer window meter updates, graphic display of fader and knob automation, and 
graphic display of Control Panel automation all take up a certain amount of CPU 
processing power–but only when the window showing the meter or automation is 
open. 

Closing any unnecessary windows will reduce the CPU processing load.

Disable meters
If things are running very tight with CPU processing power, you can disable meters 
entirely. To do this:

1. Select Disable Meters from the File menu.

If you pull down the File menu again, you’ll notice that the item’s name has 
changed to Enable meters. To re-enable the meters:

1. Select Enable Meters from the File menu.

Turn off File Sharing
File Sharing can greatly increase the time that it takes to load Multis, or to add 
Effects and Programs to a Multi. It also reduces the amount of CPU processing 
power available to both the OASYS PCI and digital audio programs. For best 
results, we recommend that you make sure that it is turned off. To do this:

1. Open the File Sharing control panel, which will show whether File Sharing 
is turned on or off. If it is turned on, press the Stop button to turn it off.
or
In the Control Strip, open the menu for the File Sharing module, and select 
“Turn File Sharing Off.”

Turn off AppleTalk
AppleTalk adds to the CPU processing load. For best results, we recommend that 
you turn it off. Most digital audio and MIDI programs recommend this, as well. To 
turn off AppleTalk:

1. In the Chooser, set AppleTalk to Inactive.
or
In the Control Strip, open the menu for the AppleTalk module, and set it to 
Inactive.

Delete unnecessary Modulation Palette routings
Each Modulation Palette routing uses a small amount of CPU processing power. If 
you aren’t using a particular routing, you can delete it to reduce the CPU 
processing load. For more information, see “Deleting a modulation routing,” on 
page 31.
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Delay effects, Samples, and resource usage
The OASYS PCI system has two types of delay effects: “short” and “long.” Short 
delays use a different type of memory than long delays, and each type of memory 
has its own advantages and disadvantages. 

Long delays use a special area of memory, which is shared with Samples but not 
with other Effects. Long delays take more DSP processing power than short 
delays. 

Short delays use the same memory as other effects (and can use it up very 
quickly), but they use less DSP processing power than long delays.

Because of this:

Use long delays in the general case, and to maximize the amount of memory 
available to other effects (such as choruses, flangers, and so on). 

Use short delays if you need to maximize DSP processing power and don’t need 
many other delay-based effects, such as choruses, flangers, etc. 

For more details, read on below.

Short delays
Delay Effects with a maximum time of 680ms or less use long circular memory, as 
shown in the Resource Monitor’s detailed view (for more details, see page 99).

This memory is shared with other delay-based Effects, such as choruses and 
flangers. This means that if you use several short delays, you may not be able to 
add any more choruses or flangers.

Short delays have an advantage over long delays, in that they use somewhat less 
DSP processing power. If you have plenty of long circular memory available, but 
are short on code cycles, then a short delay may fit when a long delay would not.

Long delays
Delay effects with a maximum time of over 680ms use DRAM circular memory, as 
shown in the Resource Monitor’s detailed view (for more details, see page 99). 
They can be quite long–up to over 40 seconds of mono delay per Effect (20 seconds 
stereo), the maximum amount of DRAM memory per chip. By using several of 
these together, you can get over 160 seconds of delay time!

The DRAM circular memory is shared between long delay Effects and Samples. If 
you’ve already loaded lots of Samples, there will be less room for long delays; 
conversely, if you’ve already loaded effects which use long delays, there will be 
less room for Samples.

Note that the whether a delay is considered “long” or “short” depends upon the 
particular effects algorithm being used, and not on the parameter settings. If you 
are using an Effect which allows delay times over 680ms, the delay will always use 
the DRAM memory, even if you set the delay time parameter to a single 
millisecond.
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One disadvantage of long delays is that they use somewhat more DSP processing 
power than short delays (even for the same amount of delay time). So, if you’re 
short on processing power, it may sometimes help to use a short delay instead.

Samples
As mentioned above, OASYS PCI’s DRAM is shared between delays and Samples. 
Each of the four effects/synths DSP chips has 6 MB of DRAM. The Samples for a 
single Patch must fit within the 6MB of DRAM belonging to a single DSP chip. 
Multiple Patches may use the DRAM on a single DSP, but Samples for a single 
Patch cannot span across the RAM of multiple DSPs.

So, you can use four Patches, each with its own 6 MB of Samples– but you can't use 
a single Patch with 24 MB of Samples.

OASYS PCI supports 24-bit Samples, allowing very high fidelity. This also means 
that the RAM hardware is designed for 24-bit sample words, as opposed to the 16-
bit words common on most samplers. So, a Sample which would take up 4 MB on a 
16-bit sampler will take up 6 MB on the 24-bit OASYS PCI. 
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Mixer
The Mixer is the heart of the OASYS PCI. It’s made up of 12 channels, each of 
which can process a Program, an Audio Input, or a Stream (from a digital audio 
program). 

Each channel includes volume, pan/balance, MIDI channel assignment, output 
bus assignment, four insert effects, and access to any two of the four effects sends. 
For a diagram of the overall signal flow, see “Overall audio block diagram” on 
page 67.

For step-by-step instructions on accomplishing common Mixer-related tasks, 
please see “Using Multis,” beginning on page 13.

Input Slot
Program: Any Program File.  

Audio Input: Analog L, R (mono) and L-R; ADAT 1-8 (mono) and 1-2, 3-4, 5-6, 7-
8 (stereo); S/PDIF L, R (mono) and L-R (stereo).  

Stream: 1-8 (mono) and 1-2, 3-4, 5-6, 7-8 (stereo). 

At the bottom of each channel is the Input Slot, which may contain either a 
Program, an Audio Input, or a Stream, as selected by the Input Type parameter 
(described on page 62).

To select an Audio Input or Stream:

1. Set the Input Type parameter as desired (Audio Input or Stream).

There is a small menu button to the right of the Input Slot. When the Input Type is 
set to Audio Input or Stream, the button becomes active.

2. Click on the menu button.

The menu contains a list of either Audio Inputs or Streams, depending on the 
selected Input Type. Each are shown as both individual mono channels and stereo 
pairs. 

3. Select the desired Audio Input or Stream from the menu.

For information on using Streams from digital audio programs, please see 
“Processing audio through OASYS PCI effects,” on page 44.

To select a Program:

1. Drag a Program from the Catalog onto the Input slot.

2. or
Select the Input slot and then double-click the name of the Program in the 
Catalog.

For more information on using the Catalog, please see the section titled “Catalog” 
on page 102.
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Double-clicking on the Program name brings up the Program Edit page, as 
described on page 80. Command-double-clicking on the Program Name brings up 
the Control Panels for the Program’s Patches, as described on page 86.
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You can copy Programs from one channel to another using drag-and-drop, or by 
using the Edit menu cut, copy, and paste commands.

You can delete a Program from a channel by using the Edit menu cut command, or 
by pressing the Delete key.

In Type (Input Type)
Program, Audio In, Stream, Off. This selects whether the channel’s input will be a 
Program, an Audio Input, or a Stream. The Input Type controls the available 
settings for the Input Slot, as described above. 

Off means that the channel is unused.

Mono/Stereo Indicator
The input to a channel can be either mono or stereo. For instance, Programs can 
have stereo or mono outputs, depending upon the Patches which they use; the 
user can also select mono or stereo audio inputs. 

Stereo inputs use two input busses, while mono inputs use only one. The 
mono/stereo display is intended to help the user to manage bus resources by 
making the mono/stereo state explicit.

MIDI (MIDI Channel)
A1-A16, B1-B16, Off. This is the MIDI channel used to control the mixer channel, 
including the mixer parameters (volume, pan, sends), the Program, and the Insert 
Effects. There are two sets of MIDI inputs, labeled A and B, with 16 channels each.

When using OMS or FreeMIDI, these correspond to the OASYS PCI A and OASYS 
PCI B devices, respectively. When using the built-in serial drivers, only the 16 “A” 
channels are used.

If you like, you can also disable MIDI control for the mixer channel by selecting 
“Off.”

You can layer Programs by setting two or more mixer channels to the same MIDI 
channel.

Level Meter
The meter shows the stereo output volume of the channel, post-effects. 

To monitor the input to the channel, double-click the Volume fader to set it to 111 
(0dB), and bypass all of the Effects by clicking on the numbers to the left of the 
Effects slots. (For more information, see “Bypassing Effects” on page 27.)

Clip Indicators
The topmost, red lights are clip indicators for the left and right channel outputs. To 
clear a channel’s clip indicators, click on them. To clear all clip indicators on the 
Mixer, option-click (MacOS) or CTRL-click (Windows) on any clip indicator.
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Vol (Volume)
0-127. Volume adjusts the volume of the mixer channel, after the insert effects. 111 is 
the default, and is equal to 0dB (unity gain). Double-clicking the fader will set it to 
111.

Volume responds to controller #7 on the selected MIDI channel.

Pan
0-127. Pan moves the signal between the left and right channels of the selected 
output bus. To create a mono output, use hard panning, left or right. 

Pan responds to controller #10 on the selected MIDI channel. A value of 64 is 
absolute center; 0 is hard left, and 127 is hard right. Double-clicking the pan knob 
will set it to 64.

Width
0-127. Width applies only to stereo channels. It controls the stereo width of the 
channel output, and interacts with Pan to determine overall stereo placement. 

With width at minimum, the channel output is a mono signal heard at the exact 
position set by Pan. With width at maximum, the channel output is wide stereo, 
centered around the Pan position.

Width responds to controller #8 on the selected MIDI channel. When this is set to 0, 
the channel is mono; when it is set to 127, the channel has the maximum stereo 
image.

Mute
On, Off. Mute silences the output of the Mixer Channel, along with its Effects 
Sends. 

Mute responds to controller #89 on the selected MIDI channel. 0 is off (not muted), 
and any value between 1 and 127 is on (muted).

Solo
On, Off. Solo isolates one or more Mixer Channels or Send Busses by temporarily 
muting all other non-soloed Mixer Channels and Send Busses. You can solo any 
combination of Channels and Send Busses at the same time.

Note that Solo affects only the mixer, and does not affect audio sent directly to the 
audio outputs from a digital audio program.

Solo responds to controller #90 on the selected MIDI channel. 0 is off (not soloed), 
and any value between 1 and 127 is on (soloed).

Output
Master, Analog L-R, S/PDIF L-R, ADAT 1-2, ADAT 3-4, ADAT 5-6, ADAT 7-8. 
This selects the Output Bus to which the mixer channel will be routed.
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If Master is selected, the Mixer Channel will go to the Output Bus designated as 
the Master Output; if the Master Output selection is changed, the Mixer Channel 
will automatically be re-routed to the new Master.

For more information, see “Output Busses,” on page 72.

Insert Effects
Each mixer channel has four slots for insert effects. The effects are applied before 
the channel volume (pre-fader), and are in series from top to bottom; effect 1 is 
first, and effect 4 is last.

Insert Effects Routing

To select an Effect:

1. Drag an Effect from the Catalog onto the desired insert slot.
or
Select an Effect slot and then double-click the name of the Effect in the 
Catalog.

For more information on using the Catalog, please see the section titled “Catalog” 
on page 102.

If no Effect is selected for an insert slot, the signal will pass through unaltered, and 
the slot will simply show “(none).”

You can copy Effects from one slot to another by using drag-and-drop, or by using 
the Edit menu’s cut, copy, and paste commands.

To delete an Effect, use the Edit menu’s cut command, or press the Delete key.

Editing Effects
To edit the Effect’s parameters, double-click on the Effect name. This will bring up 
the Effect’s Control Panel, as described on page 86.

Bypassing Effects
To bypass a single Effect, click on the slot number to the left of the Effect name. 
When bypassed, the Effect name will be grayed out. To re-enable the Effect, just 
click the slot number again. You can also bypass the Effect by using the Bypass 
button in the Effect Control Panel.

To bypass all of the Effects in the Channel, option-click (MacOS) or CTRL-click 
(Windows) on any of the Effects slot numbers. 

Insert 1 Insert 2 Insert 3 Insert 4

Volume

Input
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FX Auto-Load
On, Off. Programs and Effects-Only Programs contain Insert Effects. If the FX 
Auto-Load parameter is checked (turned on), these Effects will be loaded 
automatically when the Program or Effects-Only Program is loaded. Any Effects 
which had previously been on the Channel will be discarded.

If you want to audition Programs, set FX Auto-Load to On (checked). With this 
setting, each Program’s effects will automatically be loaded into the channel inserts. 

If you have set up a specific set of Insert Effects, and want to audition Programs 
while keeping the Effects the same, set FX Auto-Load to Off (un-checked). With this 
setting, selecting a new Program will not change the current Insert Effects.

Sends A & B
The OASYS PCI has four Send Busses, and each mixer channel can access up to two 
of these simultaneously. Sends are post-insert, and can be either pre- or post-fader.

Send Bus Select A & B
Send Bus 1-4. This selects the Send Bus used by the send. Each Send Bus can use up 
to four effects, just like the insert effects on the mixer channel. Effects are assigned 
to Send Busses in the in the Send Busses window, described on page 68.

Send Level knobs A & B
0-127. This controls the volume level of the send.

Send levels A and B respond to MIDI controllers #12 and #13, respectively. 

Send Pre/Post buttons A & B
Pre, Post. This button controls whether the send is post-insert, pre-fader, or post-
insert, post-fader.

Post is the default. With this setting, changes in the channel volume fader will affect 
the send level, so that the relative levels remain the same.

When this is set to Pre, changes in the channel volume fader do not affect the send 
level. You can even turn the channel fader all the way to zero, and the send can 
remain at maximum level. This can be used to create a sound with more “wet” than 
“dry,” to fade the dry sound in and out while the level of the wet sound remains 
constant, and so on.

Pre/Post buttons A and B respond to MIDI controllers #92 and #94, respectively. 0 
is Post, and any value between 1 and 127 is Pre.
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Post-fader send

Pre-fader send

Send Mute buttons A & B
On, Off. The Mute button temporarily silences the output of the send, setting the 
volume level to zero.

Send Mute buttons A and B respond to MIDI controllers #91 and #93, respectively. 
0 is off (not muted), and any value between 1 and 127 is on (muted).
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Send Busses

The four Send Busses are useful for effects which are heard along with the original 
signal, such as reverbs, delays, and so on. (This is as opposed to inline effects, such 
as compressors, eqs, distortion, etc., which are more appropriate for use as Mixer 
Channel insert effects.)

The Send Busses also allow multiple Mixer Channels to share the same effects, 
which helps to optimize the DSP resources of the system.

Each Mixer Channel can send to up to two of the Send Busses. Additionally, 
Streams can be summed directly into Send Busses, bypassing the Mixer Channels.
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Input Trim
0-127. The Input Trim allows you to adjust the gain into the Send Bus without 
altering each channel send individually. For instance, let’s say that the Send Bus has 
a reverb which is overloading on input, and 5 channels are routed to the Send Bus. 
You could scale back each of the 5 channels individually, one by one–or, instead, 
just reduce the overall send amount. 

For those interested in the technical side of things, this parameter works by scaling 
the send levels on each channel, and does not add another gain stage.

Input Trim responds to MIDI controller #12 on the selected MIDI channel.

Note: this parameter only controls the send levels on the OASYS PCI mixer. It has 
no effect on Streams directly summed into the Send Bus.

Effects 1-4
Each Send Bus can have up to four effects. The effects are in series from top to 
bottom; effect 1 is first, and effect 4 is last.

Send Effects Routing

To select an Effect:

1. Drag an Effect from the Catalog onto the desired insert slot.
or
Select an Effect slot and then double-click the name of the Effect in the 
Catalog.

For more information on using the Catalog, please see the section titled “Catalog” 
on page 102.

If no Effect is selected for a slot, the signal will pass through unaltered, and the slot 
will simply show “(none).”

You can copy Effects from one slot to another by using drag-and-drop, or by using 
the Edit menu’s cut, copy, and paste commands.

To delete an Effect, use the Edit menu’s cut command, or press the Delete key.

Editing Effects
To edit the Effect’s parameters, double-click on the Effect name. This will bring up 
the Effect’s Control Panel, as described on page 86.

Insert 1 Insert 2 Insert 3 Insert 4

VolumeFX Send
Master Vol
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Bypassing Effects
To bypass an Effect, click on the slot number to the left of the Effect name. When 
bypassed, the Effect name will be grayed out. To re-enable the Effect, just click the 
slot number again. You can also bypass the Effect by using the Bypass button in 
the Effect Control Panel.

To bypass all of the Effects in the Send Bus, option-click (MacOS) or CTRL-click 
(Windows) on any of the Effects slot numbers. 

MIDI (MIDI Channel)
A1-A16, B1-B16, Off. This is the MIDI channel used to control the mixer channel, 
including the mixer parameters (volume, pan, sends), the Program, and the Insert 
Effects. There are two sets of MIDI inputs, labeled A and B, with 16 channels each.

When using OMS or FreeMIDI, these correspond to the OASYS PCI A and OASYS 
PCI B devices, respectively. When using the built-in serial drivers, only the 16 “A” 
channels are used.

If you like, you can also disable MIDI control for the Send Bus by selecting “Off.”

Level Meter
The meter shows the stereo output volume of the bus, post-effects. 

To monitor the input to the bus, set the Volume fader to 127, and bypass all of the 
effects.

Clip Indicators
The topmost, red lights are clip indicators for the left and right Send Bus outputs. 
To clear a Send Bus’s clip indicators, click on them. To clear all clip indicators on 
the Mixer, option-click (MacOS) or CTRL-click (Windows) on any clip indicator.

Vol (Volume)
0-127. Volume adjusts the volume of the effect return. 111 is the default, and is 
equal to 0dB (unity gain). Double-clicking the fader will set it to 111.

Volume responds to controller #7 on the selected MIDI channel.

Pan
0-127. Pan moves the signal between the left and right channels of the selected 
Output Bus. To create a mono output, use hard panning, left or right. 

Pan responds to controller #10 on the selected MIDI channel. A value of 64 is 
absolute center; 0 is hard left, and 127 is hard right. Double-clicking the pan knob 
will set it to 64.

Width
0-127. Width controls the stereo width of the Send Bus output, and interacts with 
Pan to determine overall stereo placement. 
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With width at minimum, the Send Bus output is a mono signal heard at the exact 
position set by Pan. With width at maximum, the output is wide stereo, centered 
around the Pan position.

Width responds to controller #8 on the selected MIDI channel. When this is set to 0, 
the channel is mono; when it is set to 127, the channel has the maximum stereo 
image.

Mute
On, Off. Mute silences the output of the Send Bus. 

Mute responds to controller #89 on the selected MIDI channel. 0 is off (not muted), 
and any value between 1 and 127 is on (muted).

Solo
On, Off. Solo isolates one or more Mixer Channels or Send Busses by temporarily 
muting all other non-soloed Mixer Channels and Send Busses. You can solo any 
combination of Channels and Send Busses at the same time.

Note that Solo affects only the mixer, and does not affect audio sent directly to the 
audio outputs from a digital audio program.

Solo responds to controller #90 on the selected MIDI channel. 0 is off (not soloed), 
and any value between 1 and 127 is on (soloed).

Output
Master, Analog L-R, S/PDIF L-R, ADAT 1-2, ADAT 3-4, ADAT 5-6, ADAT 7-8. 
This selects the Output Bus to which the Send Bus will be routed.

If Master is selected, the Send Bus will go to the Output Bus designated as the 
Master Output; if the Master Output selection is changed, the Send Bus will 
automatically be re-routed to the new Master.

For more information on output busses, see “Output Busses,” on page 72.

Stream Input
None, Stream 1-8 (mono), Stream 1-2, 3-4, 5-6, 7-8 (stereo). This selects the Stream 
which will be summed into the Send Bus. 

The Stream Input allows Send Busses to be shared by the OASYS PCI mixer and a 
digital audio program. For instance, you can have a reverb send which is used by 
both OASYS PCI synths and pre-recorded audio tracks. For more information, 
please see “Routing audio to an OASYS PCI Send Bus,” on page 44.

If None is selected, no stream will be summed into the send.
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Output Busses

Each pair of audio outputs has a corresponding Output Bus, and all audio going 
from the Mixer to an audio output pair goes through an Output Bus first. Output 
Busses include insert effects, a volume fader, and mute and solo controls.

Mixer Channels and Send Busses are routed to Output Busses. Direct outputs from 
digital audio programs bypass the Output Busses, and instead go directly to the 
physical outputs.
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Output Busses example

Effects 1-4
Output Bus insert effects let you apply EQ, compression, and other overall effects to 
groups of tracks. As with mixer channels, each Output Bus can have up to four 
effects. The effects are in series from top to bottom; effect 1 is first, and effect 4 is 
last.

Output Bus Effects Routing

To select an Effect:

1. Drag an Effect from the Catalog onto the desired insert slot.
or
Select an Effect slot and then double-click the name of the Effect in the 
Catalog.

For more information on using the Catalog, please see the section titled “Catalog” 
on page 102.
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If no Effect is selected for a slot, the signal will pass through unaltered, and the slot 
will simply show “(none).”

You can copy Effects from one slot to another by using drag-and-drop, or by using 
the Edit menu’s cut, copy, and paste commands.

To delete an Effect, use the Edit menu’s cut command, or press the Delete key.

Editing Effects
To edit the Effect’s parameters, double-click on the Effect name. This will bring up 
the Effect’s Control Panel, as described on page 86.

Bypassing Effects
To bypass a single Effect, click on the slot number to the left of the Effect name. 
When bypassed, the Effect name will be grayed out. To re-enable the Effect, just 
click the slot number again. You can also bypass the Effect by using the Bypass 
button in the Effect Control Panel.

To bypass all of the Effects in the Output Bus, option-click (MacOS) or CTRL-click 
(Windows) on any of the Effects slot numbers. 

MIDI (MIDI Channel)
A1-A16, B1-B16, Off. This is the MIDI channel used to control the Output Bus, 
including the mixer parameters (volume, pan, mute, and solo) and the Effects. 
There are two sets of MIDI inputs, labeled A and B, with 16 channels each.

When using OMS or FreeMIDI, these correspond to the OASYS PCI A and OASYS 
PCI B devices, respectively. When using the built-in serial drivers, only the 16 “A” 
channels are used.

If you like, you can also disable MIDI control for the Output Bus by selecting 
“Off.”

Level Meter
The meter shows the stereo output volume of the bus, post-effects. 

To monitor the input to the bus, set the Volume fader to 127, and bypass all of the 
effects.

Clip Indicators
The topmost, red lights are clip indicators for the left and right channels of the 
Output Bus. To clear an Output Bus’s clip indicators, click on them. To clear all clip 
indicators on the Mixer, option-click (MacOS) or CTRL-click (Windows) on any 
clip indicator.

Vol (Volume)
0-127. Volume adjusts the volume of the Output Bus. 111 is the default, and is 
equal to 0dB (unity gain). Double-clicking the fader will set it to 111.
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Volume responds to controller #7 on the selected MIDI channel.

Mute
On, Off. Mute silences the Output Bus. 

Mute responds to controller #89 on the selected MIDI channel. 0 is off (not muted), 
and any value between 1 and 127 is on (muted).

Solo
On, Off. Solo isolates the Output Bus, temporarily muting all other non-soloed 
Output Busses. 

Solo responds to controller #90 on the selected MIDI channel. 0 is off (not soloed), 
and any value between 1 and 127 is on (soloed).

To Master
On, Off. This button sends the Output Bus through the Master Output Bus, in 
addition to the normal output. This can be used for various purposes, including:

• Isolating a sound for recording, while still monitoring it through the Master 
Output.

• Submixing sounds through bus effects, and then sending the submix to the 
Master Output (and through any additional effects on the Master Output 
Bus).

To Master can increase DSP processing requirements
Activating an Output Bus’s To Master function may sometimes require the 
Programs and Effects to be re-arranged within the DSPs. This may decrease the 
effective amount of DSP processing power available. In some cases, this may mean 
that there may not be enough DSP processing power to play a Multi which 
previously played successfully.

If this happen, you can reduce the number of Output Busses routed to the Master 
output, or use other methods to reduce the DSP processing load, as described 
under “Managing Resources,” beginning on page 53.

Master Bus radio button
On, Off. This selects the Master Output Bus. 

Mixer Channels and Send Busses assigned to the Master Output will automatically 
follow the Master Bus selection; if you change the Master Bus, their outputs will 
change as well.

For instance, you might set all Mixer Channels to go to the Master Output, with the 
analog outputs selected as the Master Bus for easy monitoring. You could then send 
all of the Mixer Channels to the S/PDIF outputs, for recording, simply by switching 
the Master Bus to S/PDIF–instead of changing each Mixer Channel individually.
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Also, other Output Busses can be summed into the Master Bus, using the To 
Master button, as described above.

Default Master Output Bus preferences
The Preferences window “Master Output Bus” parameter allows you to set a 
default Master Bus, which is used whenever you create a new Multi.

You can also use the Preferences window “Reset Master Output Bus When 
Opening Multis” parameter to automatically set all Multis to use the default 
Master Bus. Use this feature if you always want to audition sounds through a 
specific Output Bus.
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Channel Parameters

The Channel Parameters page allows you to set various parameters for the 
Programs used in the Multi. Aside from the Input Type and Program/Audio Input 
parameters, all of the settings on this page apply to Programs only.

Ch (Channel Number)
This column shows the Mixer Channel number for reference, and is not user-
editable. 

Input Type
Program, Audio In, Stream, Off. This selects whether the channel’s input will be a 
Program, an Audio Input, or a Stream. The Input Type controls the available 
settings for the Input Select parameter.
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Off means that the channel is unused, allowing the OASYS PCI Engine to optimize 
the Mixer (for more information, see “Managing Resources” on page 53).

Note that all of the parameters on this page, except for the Program/Audio Input 
select, apply only to Programs.

Program/Audio Input
Program: Any Program File.  

Audio Input: Analog L, R (mono) and L-R; ADAT 1-8 (mono) and 1-2, 3-4, 5-6, 7-
8 (stereo); S/PDIF L, R (mono) and L-R (stereo).  

Stream: 1-8 (mono) and 1-2, 3-4, 5-6, 7-8 (stereo). 

This is the same as the input select for the Mixer Channel.

The input may be either a Program, an Audio Input, or a Stream (from a digital 
audio program), as selected by the Input Type parameter.

To select an Audio Input or Stream:

1. Set the Input Type parameter as desired (Audio Input or Stream).

2. Select the desired Audio Input or Stream from the menu.

Clicking on the menu shows a list of either Audio Inputs or Streams, depending on 
the selected Input Type. Audio Inputs and Streams are shown as both mono and 
paired stereo. 

To select a Program:

1. Drag a Program from the Catalog onto the Input Select parameter.
or
Select the Input slot and then double-click the name of the Program in the 
Catalog.

For more information on selecting Programs, please see “Editing a Patch” on 
page 20.

Double-clicking on the Program name brings up the Program Edit page, as 
described on page 80.

You can copy Programs from one channel to another using drag-and-drop, or by 
using the Edit menu cut, copy, and paste commands.

You can delete a Program from a channel by using the Edit menu cut command, or 
by pressing the Delete key.

Coarse Tune
-48 to +48. This is the coarse tuning, in semitones, for the Program.

Fine Tune
-100 to +100. This is the fine tuning, in cents (1/100 of a semitone), for the 
Program.
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Low Key/High Key
C-1 to G9. These are the high and low MIDI notes to which the Program will 
respond. When selected, you can set them by playing notes on your MIDI 
controller.

The Low Key and High Key parameters act in addition to any key windows 
assigned to Patches in the Program. The union of the two windows produces the 
final result. See the diagram, below, for an example.

Cumulative Program and Patch high/low key windows

Low Vel/High Vel
1 to 127. These are the high and low MIDI velocities to which the Program will 
respond. When selected, you can set them by playing on your MIDI controller.

As with Low/High Key, above, these act in addition to any velocity windows 
assigned to Patches in the Program. 

Program key window: 

Patch key window: 

Resulting key window: C4 to A6

Patch

Program

ResultC-1 to A6

C4 to G9
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Program Edit

Programs are the basic sounds of the OASYS PCI, and must be placed on a Mixer 
Channel to be played. They play one or two Patches, which can be layered or split 
by key and velocity ranges. They also have up to four Insert Effects, which appear 
in the Mixer Channel. Programs store all Control Panel settings for their Patches 
and Effects.

For step-by-step instructions on accomplishing common Program-related tasks, 
please see “Using Programs & Patches,” beginning on page 19.

Program Name
This is the name of the Program.

Patch
One or two Patches may be used in a Program.
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To add a Patch to a Program:

1. Drag a Patch from the Catalog onto the desired Patch slot.

(MacOS Only: Alternatively, you can select the Patch slot and then double-click the 
name of the Patch in the Catalog.)

For more information on using the Catalog, please see the section titled “Catalog” 
on page 102.

You can also leave a Patch slot empty, in which case it will simply show “(none).”

Double-clicking on the Patch name brings up the Patch’s Control Panel, as 
described on page 86.

You can copy Patches from one slot or Program to another using drag-and-drop, or 
by using the Edit menu’s cut, copy, and paste commands.

You can delete a Patch from a Program by using the Edit menu’s cut command.

Voices
1 to n. This is the number of voices allocated to the Patch. You can allocate different 
numbers of voices to each Patch within the Program, if desired.

Volume
0-127. This sets the relative volume levels of the Patches in the Program.

The overall level of the Program is controlled by the Mixer Channel’s Volume 
parameter.

Coarse Tune
-48 to +48.  This is the coarse tuning, in semitones, for the selected Patch.

Fine Tune
-100 to +100.  This is the fine tuning, in cents (1/100 of a semitone), for the selected 
Patch.

Pitch Bend
Off, Global, Half Step, Whole Step, Min. 3rd, Maj. 3rd, Perfect 4th, Dim. 5th, 
Perfect 5th, Min. 6th, Maj. 6th, Min. 7th, Maj. 7th, Octave. This parameter 
determines how the Patch will respond to pitch bend. 

Global. This is the default; the Patch uses the global pitch bend range, as set in the 
Preferences window (as described on page 111). 

Half Step through Octave. This sets the Patch to a specific pitch bend range, which 
is not dependent on the Global setting.
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Scale
This selects the scale used by the Patch. Scales allow each individual MIDI note to 
be tuned as desired.

For more information, see “Scales,” on page 131.

Low/High Key and Velocity
All of the key and velocity windowing parameters, including Low Key, High Key, 
Low Velocity, and High Velocity, act in addition to the windows assigned to the 
Program in a Multi. The union of the two windows produces the final result, as 
shown in the diagram below:

Cumulative Program and Patch high/low key windows

Low Key
C-1 to G9. This is the lowest MIDI note to which the Patch will respond. All notes 
below the Low Key will be ignored. When this parameter is selected, you can set it 
by playing a note on your MIDI controller.

High Key
C-1 to G9. This is the highest MIDI note to which the Patch will respond. All notes 
above the High Key will be ignored. When this parameter is selected, you can set it 
by playing a note on your MIDI controller.

Low Velocity
1 to 127. This is the lowest MIDI velocity to which the Patch will respond. All notes 
with velocities below the Low Velocity will be ignored. When this parameter is 
selected, you can set it by playing on your MIDI controller.

Program key window: 

Patch key window: 

Resulting key window: C4 to A6

Patch

Program

ResultC-1 to A6

C4 to G9
82 OASYS PCI



Reference Program Edit
High Velocity
1 to 127. This is the highest MIDI velocity to which the Patch will respond. All notes 
with velocities above the High Velocity will be ignored. When this parameter is 
selected, you can set it by playing on your MIDI controller.

Voice Allocation
Polyphonic, Poly Physical, Poly Retrig, Poly Reuse, Mono Legato, Mono Retrig, 
Unison. The Voice Allocation parameter determines how the Patch responds to 
new notes, and how voices are stolen when the maximum number of voices is 
exceeded.

Note that the Patch’s algorithm design affects the way that the Patch responds to 
the different Voice Allocation settings. Some Patches may not work properly with 
certain settings.

Polyphonic. This is the default setting; you can play as many voices as the 
algorithm allows, up to the number set in the Voices parameter. When new notes 
are played, or when voice-stealing is necessary, the oldest voices will be discarded. 

If a single note is played repeatedly, each key-press starts a new voice. For example, 
if you are repeatedly hitting a crash cymbal, the crashes will overlap, each going 
through its full decay and release.

Poly Physical. This is the same as Polyphonic, except for one important detail: 
when re-striking a note which is being held with the sustain pedal, the current 
voice will be re-used. For some specifically-designed physical modelling Patches, 
this will make the re-struck note sound different from the previous note. 

For instance, in the real world, when you strike a cymbal twice in a row, the second 
strike makes a different sound than the first; it adds energy to the previous crash, 
and the sound becomes more intense. 

Patches must be specifically designed to take advantage of this allocation setting.

Poly Retrig. This is similar to Polyphonic, above, except that when a new note is 
played, the most recently played available voices will be chosen. This is intended to 
be used in conjunction with analog-style polyphonic portamento, allowing one 
chord to slide into another. You can even play a lead line while holding down a 
chord, and the lead line will have proper note-to-note portamento.

(This option does not turn on portamento by itself; that must be done in the Patch, 
and the Patch itself must also support portamento.)

Poly Reuse. This mode models the voice allocation of a classic “prophetic” analog 
synth. When a note is played, if there is any voice that was last triggered by that 
note, then that voice will be used. The envelopes of re-used notes will reflect the 
previous state, instead of re-starting from scratch. Unlike Poly Physical, it doesn't 
matter if the voice is being sustained, or still making sound of any kind.

Mono Legato. Only one voice will play at a time. When notes are played with 
legato phrasing–so that the next note is started before the previous one is released–
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notes are not re-triggered; the envelopes will continue to evolve as if the original 
note was still held down. This is good for imitating the phrasings of wind 
instruments, or analog lead synthesizers, and is generally the preferred mode for 
MIDI wind controllers. Mono Legato mode must be specifically supported in the 
Patch.

Mono Retrig. Only one note will play at a time. Unlike Mono Legato, each key-
press starts a new note and re-triggers envelopes. 

Unison. Unison mode plays only one note at a time, but uses two or more stacked, 
detuned voices to create a thick sound. Use the Unison Voices and Unison Detune 
parameters to set the number of voices and amount of detuning.

Key Priority
Last Key, Highest Key, Lowest Key. When a Patch’s Voice Allocation parameter is 
set to Mono Legato. Mono Retrig, or Unison, the Patch will play only one note at a 
time. The Key Priority parameter determines what happens when more than one 
note is being held down.

When Polyphonic, Poly Physical, or Poly Retrig modes are selected, this parameter 
does not apply. 

Last Key. The most recently played note will sound. This is the default.

Highest Key. The highest note will sound.

Lowest Key. The lowest note will sound. Many vintage, monophonic analog 
synths work this way.

Unison Detune
0 to 100.  This parameter only applies when Voice Allocation is set to Unison. It 
sets the tuning spread, in cents (1/100 of a semitone), for the Unison voices. The 
Patch’s voices are distributed evenly across the detune amount, centered around 
the basic pitch. 

For instance, let’s say that the Patch’s Voices parameter is set to 3, and Unison 
Detune is set to 24:

Voice one will be detuned down by 12 cents, voice two will not be detuned, and 
voice three will be detuned up by 12 cents.

Voice Detune

1 -12

2 0

3 +12
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As another example, let’s say that the Unison Detune is still set to 24, but Voices is 
set to 4:

Voice one will still be detuned down by 12 cents, voice two will be detuned down 
by 4 cents, voice three will be detuned up by 4 cents, and voice 4 will be detuned up 
by 12 cents.

Effects
Programs store settings for the Mixer Channel Insert Effects. If the channel’s Auto-
Load FX parameter is enabled, then these Effects will be loaded automatically.

To select, edit, or delete Insert Effects for a Program, use the mixer channel. After 
the Insert Effects have been edited, they can be saved with the Program using the 
File Menu’s “Save Program and Effects As…” command. This command is only 
shown when the Program Edit window is in the foreground.

Voice Detune

1 -12

2 -4

3 +4

4 +12
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Control Panel

General
The Control Panel allows you to edit the parameters of Patches and Effects. 

Each Patch and Effect has its own Control Panel, specifically designed for the 
Patch or Effect’s particular features. This means that the Control Panel may 
contain completely different parameters, depending on which Patch or Effect is 
being edited.

The mixer channel number, Program name (if a Patch), and Patch or Effect name 
are shown in the Control Panel window’s title bar.

Control Panel Objects
Knobs. Move knobs by dragging the mouse either vertically, up and down, or 
horizontally, left and right, just like you would move a slider. They are not 
designed to be “turned” in a circular motion; doing so will produce undesired 
results! 
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For fine control, you can increment and decrement the knob’s value using the up 
and down arrows on the keyboard. You can also type directly into the numeric 
field.

Sliders. For fine control of slider values, you can increment and decrement by 
using the up and down arrows on the keyboard. You can also type directly into the 
numeric field.

Menus. Menus allow you to select between different options by name.

Radio Buttons. Radio buttons are used for selecting between a small number of 
choices.

Check Boxes. Check boxes turn a parameter on and off.

Meters. Meters are used to display audio levels, gain reduction, and other levels.

Multisamples. Sample-based Patches include slots for one or more Multisamples. 
To select a new Multisample, just drag it from the Catalog into the Multisample slot 
in the Control Panel.

Modulating Parameters

Fixed Modulation Paths
Many Patches and Effects offer built-in modulation paths for certain parameters. 
Sometimes, these modulation paths will be “hard wired,” meaning that the amount 
of modulation can be altered, but the source of the modulation is fixed. For 
instance, a filter envelope might be hard-wired to control the filter cutoff.

Also, most parameters on the Mixer screens have preset MIDI modulation routings; 
for more information, see “Mixer parameters have preset modulation routings,” on 
page 33.

Assignable Modulation Paths
Patches and Effects may also offer assignable modulation paths, so that you can 
choose the source of the modulation. Assignable modulation paths include an 
extensive menu of MIDI modulation sources, as detailed under “Modulation 
Sources,” below.

User-Created Modulation Routings
One of the special features of the OASYS PCI is that all Control Panel parameters 
are modulatable–even if they don’t have built-in modulation routings. This is done 
through the Modulation Palette. 

Just click on the name of a Control Panel parameter to bring up the Modulation 
Palette (or to assign the Palette to the current parameter, if the Palette is already 
open). For on/off buttons, option-click (MacOS) or CTRL-click (Windows) on the 
name.

Once the Modulation Palette is open, select one or two mod sources, enter the 
desired mod amounts, and you’re ready to go. 
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When a modulation routing is assigned, the name of the modulated Control Panel 
parameter will be underlined and colored red. 

For more information, see “Modulation Palette,” on page 91.

Modulation Sources
None. No modulation will be applied.

Velocity.  MIDI note-on velocity. When modulating Effects, the most recent 
velocity will be used.

Exp. Velocity. MIDI note-on velocity, through an exponential curve. This creates 
more variation at high velocities, and less variation at lower velocities. When 
modulating Effects, the most recent velocity will be used.

Note. MIDI note number. When modulating Effects, the most recent note number 
will be used.

Note+Pitchbend. This selection adds the Pitch Bend amount to the MIDI note 
number, for more precise pitch-related modulation. When modulating Effects, the 
most recent note number will be used.

Exp. Note. MIDI note number, through an exponential curve. This creates more 
variation from note to note at the high end of the keyboard, and less variation at 
the low end. At C2, the value is very small; at C7, it is about 90% of maximum. 
When modulating Effects, the most recent note number will be used.

Exp. Note+Pitchbend. This selection adds the Pitch Bend amount to the 
exponential MIDI note number, for more precise pitch-related modulation. When 
modulating Effects, the most recent note number will be used.

Note Gate.  This is an on/off mod source. When the key is held down, the 
modulation is at maximum; when the key is released, the modulation goes to zero. 
Note Gate is intended for use in Patches, and does not work for modulation of 
Effects parameters.

Note Gate+Sustain. This adds the Sustain pedal to Note gate. When the key or the 
Sustain pedal is held down, the modulation is at maximum; when the key or the 
Sustain pedal is released, the modulation goes to zero. Note Gate+Sustain is 
intended for use in Patches, and does not work for modulation of Effects 
parameters.

Any Note Gate. This is a version of Note Gate which will work with both Patches 
and Effects. As long as any key is held down, the modulation is at maximum; 
when all keys are released, the modulation goes to zero.

Any Note Gate+Sustain. This adds the sustain pedal to Any Note Gate, and will 
work with both Patches and Effects. As long as any key or the sustain pedal is held 
down, the modulation is at maximum; when all keys are released, and the sustain 
pedal is lifted, the modulation goes to zero.

Mod Wheel. MIDI Modulation Wheel (controller #1).

Aftertouch. MIDI Aftertouch.
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Mod Wheel+AT. This is the sum of Mod Wheel and Aftertouch. 

Mod Wheel+AT/2. This is similar to Mod Wheel+AT, but the affect of Aftertouch is 
cut in half.

Pitchbend. This is MIDI Pitchbend, exactly as received, prior to scaling.

Pitchbend Scaled. This is MIDI Pitchbend, as scaled by the Global or Program 
Pitch Bend parameters.

Sustain. MIDI Sustain Pedal (controller #64).

MIDI A-H. These are the eight assignable MIDI controllers, as set in the MIDI 
Preferences (described under “Factory Settings,” on page 116).

MIDI Tempo. This receives MIDI Clock, for synching delays, LFOs, and other 
tempo-based effects. In general, the Patch or Effect must be specifically designed 
for MIDI Tempo in order to obtain meaningful results.

MIDI Start/Stop. This receives MIDI Start/Stop, for controlling analog-style 
sequencers or other components which can start and stop with an external MIDI 
sequencer. In general, the Patch or Effect must be specifically designed for MIDI 
Start/Stop in order to obtain meaningful results.

Keytrack Linear. Linear keyboard tracking, centered on C4. See the graphs below.

Keytrack Exp. Exponential keyboard tracking, centered on C4, for more variation 
at the extremes of the keyboard. See the graphs below.

Keytrack Log. Logarithmic keyboard tracking, centered on C4, for more variation 
in the middle of the keyboard. See the graphs below.

Keytrack Left Lin. Linear keyboard tracking below C4, with no modulation above 
C4. See the graphs below.

Keytrack Left Exp. Exponential keyboard tracking below C4, with no modulation 
above C4. See the graphs below.

Keytrack Left Log. Logarithmic keyboard tracking below C4, with no modulation 
above C4. See the graphs below.

Keytrack Right Lin. Linear keyboard tracking above C4, with no modulation 
below C4. See the graphs below.

Keytrack Right Exp. Exponential keyboard tracking above C4, with no modulation 
below C4. See the graphs below.

Keytrack Right Log. Logarithmic keyboard tracking above C4, with no modulation 
below C4. See the graphs below.
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Modulation Palette

The Modulation Palette allows you to create up to two modulation paths for each 
Patch or Effect Control Panel parameter.

You can open the Modulation Palette by clicking on the name of a Control Panel 
parameter. For on/off buttons, option-click (MacOS) or CTRL-click (Windows) on 
the name.

If the Modulation Palette is already open, clicking on a Control Panel parameter 
will change the Modulation Palette to show the settings for that parameter.

When a modulation routing is assigned, the name of the modulated Control Panel 
parameter will be underlined and colored red.

For step-by-step instructions on accomplishing common modulation-related tasks, 
please see “Using Modulation,” beginning on page 30.

Source A and B
An extensive set of MIDI modulation sources is available. For a complete list, 
see“Modulation Sources,” on page 88.

Amount A and B
-100 to +100. This sets the amount by which the modulation source affects the 
Control Panel parameter. 

The amount is a percentage of the total range of the parameter. When the Amount 
is set to +100, a MIDI modulation value of 127 will take the parameter all the way to 
the maximum value, even if the Control Panel knob or slider is at its very lowest 
setting.
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Conversely, when the Amount is set to -100, a MIDI modulation value of 127 will 
take the parameter all the way to the minimum value, even if the Control Panel 
knob or slider is at its very highest setting. 
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Multisample Edit

For step-by-step instructions on accomplishing common tasks with Samples and 
Multisamples, please see “Using Samples & Multisamples,” beginning on page 35.

General Information
Multisamples group together one or more Samples, assign the samples to ranges on 
the keyboard, and allow you to adjust a handful of common parameters (such as 
volume and filter cutoff) for each Sample.

You can open the Multisample editor by double-clicking on a Multisample in a 
Patch Control Panel.

OASYS PCI can use 16-bit and 24-bit samples in a number of different formats, 
including AIFF, WAV, and Korg’s proprietary .kes format. Additionally, Sound 
Designer II format samples are supported on MacOS only.

Key Ranges
A Multisample divides the keyboard into one or more Key Ranges, as shown by the 
boxes drawn above the keyboard. Each Key Range contains a Sample and various 
parameters which control the way that the Sample is played. You can assign the 
same Sample to multiple Key Ranges.

You can select a Key Range by playing a note on your MIDI controller, or by 
clicking on the onscreen keyboard. You can also click in the boxes shown above the 
keyboard, which show the name of the Sample assigned to the Key Range. 

NOTE: To view the window at full resolution, zoom in to 200%.
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The parameters for the selected Key Range are shown at the top of the window, 
including an assigned Sample, high key, low key, and base key, Exclusive Group 
assignment, and offsets for volume, pan, tuning, cutoff, and decay.

You can assign Key Ranges across all 128 MIDI notes. Use the scroll bar at the 
bottom of the window to show the desired part of the keyboard. If you have a 
large monitor, you can also expand the window horizontally to show more of the 
keyboard at a time.

A note on MIDI editing
When the Multisample Edit window is open, incoming MIDI selects the current 
Key Range. In conjunction with command keys on the computer keyboard, you 
can also use MIDI to edit the High Key, Low Key, and Base Key of the selected Key 
Range.

The Mixer channel’s MIDI channel assignment, and all Multi and Program key 
and velocity windows, all apply to MIDI received in this window. If MIDI is on the 
wrong channel, or is outside of the key and velocity ranges, then it will have no 
effect. 

Multisample Name
This is the name of the Multisample. Clicking on the name will change the cursor 
into a standard text editing bar; you can then edit the name just as you would any 
other text.

Remember that this only changes the name of the Multisample within the Multi. 
To save the new name to disk, use the “Save Multisample As...” command in the 
File menu.

Sample
This is the Sample assigned to the selected Key Range. 

To change the Sample assigned to a Key Range, just drag a new Sample from the 
Catalog into the Sample slot. All other parameters remain unchanged.

(MacOS Only: Alternatively, you can select the Sample slot and then double-click 
the name of the Sample in the Catalog.)

For more information on using the Catalog, please see the section titled “Catalog” 
on page 102.

You can also leave a Sample slot empty, in which case it will simply show 
“(none).” Playing a note in the Key Range will then play a special “silent” Sample, 
which takes up one voice of polyphony. (See the Exclusive Group’s Silent setting, 
below, for a way to create a silent zone on the keyboard which will not affect 
polyphony.)

You can cut, copy, and paste Samples between different Key Ranges. To do so, first 
select the Sample parameter, and then use the desired Edit menu command.
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Low Key
C-1 to G9. This is the lowest MIDI note of the Key Range. When this parameter is 
selected, you can set it by playing a note on your MIDI controller. 

Holding down the option key (MacOS) or shift-left-bracket “[” (Windows) on your 
computer keyboard will also select this parameter, after which you can set it by 
playing a note on your MIDI controller. This allows you to quickly select and edit 
Key Ranges without needing to use the mouse.

You can also set the Low Key graphically. To do so, just move the cursor over the 
edge of a Key Range box (above the onscreen keyboard graphic). When the cursor 
changes to a double-arrow shape, click and drag the edges of the Key Range as 
desired.

High Key
C-1 to G9. This is the highest MIDI note of the Key Range. When this parameter is 
selected, you can set it by playing a note on your MIDI controller.

Holding down the command key (MacOS) or shift-right-bracket “]” (Windows) on 
your computer keyboard will also select this parameter, after which you can set it 
by playing a note on your MIDI controller. This allows you to quickly select and 
edit Key Ranges without needing to use the mouse.

You can also set the High Key graphically. To do so, just move the cursor over the 
edge of a Key Range box (above the onscreen keyboard graphic). When the cursor 
changes to a double-arrow shape, click and drag the edges of the Key Range as 
desired.

Base Key
C-1 to G9. This is the MIDI note at which the Key Range’s Sample is untransposed - 
the pitch at which it was sampled. The Base Key may be beyond the High and Low 
keys of the Key Range. 

When this parameter is selected, you can set it by playing a note on your MIDI 
controller.

Holding down the option and command keys (MacOS) or shift-backslash “\” 
(Windows) on your computer keyboard will also select this parameter, after which 
you can set it by playing a note on your MIDI controller. This allows you to quickly 
select and edit Key Ranges without needing to use the mouse.

You can also set the Base Key graphically. To do so, just click on the Key Range’s 
Base Key on the graphic keyboard (shown in red) and drag it to a new location.

Tune
-100 to +100.  This is the fine tuning offset, in cents (1/100 of a semitone), for the 
selected Key Range.
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This parameter serves as an offset to any tuning set in the Patch containing the 
Multisample. Some Patches may not support this offset.

Volume
-100 to +100.  This is the volume offset for the selected Key Range.

This parameter serves as an offset to any volume set in the Patch containing the 
Multisample. Some Patches may not support this offset.

Pan
0 to 127.  This is the pan offset for the selected Key Range.

This parameter serves as an offset to any pan set in the Patch containing the 
Multisample. Some Patches may not support this offset.

Cutoff
-100 to +100.  This is the filter cutoff offset for the selected Key Range.

This parameter serves as an offset to any filter cutoff set in the Patch containing the 
Multisample. Some Patches may not support this offset (for instance, if they do not 
have a filter).

Decay
-100 to +100.  This is the envelope decay time offset for the selected Key Range.

This parameter serves as an offset to the envelope decay time set in the Patch 
containing the Multisample. Some Patches may not support this offset.

Exclusive Group
Exclusive Groups allow you to create a monophonic set of keys, so that only one 
note in the Exclusive Group will sound at a time. If another key within the group is 
played, the previously played note will be cut off. For instance, you can use this so 
that a closed hi-hat Sample cuts off the sound of an open hi-hat.

Multiple Key Ranges may be assigned to the same Exclusive Group.

Off. The Key Range will act normally.

1-63. The Key Range will be assigned to the selected Exclusive Group. 

Silent. The Key Range will be silent. When you play a key within the range, no 
voices will be allocated.

NOTE: This is different from deleting a Sample so that it appears as (none). If the 
Sample is set to (none), the Patch will play a special “silent” Sample, which takes 
up one voice of polyphony.

Exclusive Group settings are controlled by the top Multisample
Many PCM Patches have more than one Multisample. For instance, many have 
High and Low Multisamples, for creating velocity splits. In this case, the Exclusive 
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Group settings for all Multisamples are controlled by the top Multisample. The 
Exclusive Group parameters for all other Multisamples will be grayed out.

Exclusive Group settings not available in some Patches
Some Patches may not support Exclusive Group functionality. If a Multisample is 
placed in such a Patch, all Exclusive Group parameters will be grayed out.

Show Parameter
This menu allows you to choose one parameter, such as Volume or Pan, to be 
displayed for all of the Key Ranges simultaneously. The value is shown as a slider 
within the Key Range boxes above the onscreen keyboard, allowing you to see the 
settings for all Key Ranges at once.

For complete explanations of the individual parameters, see their descriptions 
above.

None. This makes the sliders disappear, for easier viewing of the Sample names.

Volume. This shows the sliders for the Volume offset.

Pan. This shows the sliders for the Pan offset.

Cutoff. This shows the sliders for the Cutoff offset.

Tune. This shows the sliders for the Tune offset.

Decay. This shows the sliders for the Decay offset.

Exclusive Group. This shows the sliders for the Exclusive Group assignments.

To select the parameter being displayed, use the Show Parameter menu. The 
selections include most of the numeric edit fields at the top of the window: Volume, 
Pan, Cutoff, Tune, Decay, and Exclusive Group. A final setting, None, makes the 
sliders disappear, for easier viewing of the sample names.

To edit the parameter for a specific range, just move the on-screen slider. The value 
is shown within the slider handle. To edit the value numerically (using keypad, 
inc/dec etc.), use the normal edit fields at the top of the window.

Sliders are drawn on top of sample names. If you need to have an unobstructed 
view of all of the names, choose “None” from the Show Parameter menu to 
temporarily hide the sliders.

Note that the Multisample does not actually contain filtering, panning, and so on; 
these offsets depend on the Patch to support these functions. Some Patches may not 
support all of the parameters seen here.

Assigning a Sample to a new Key Range
To add a Sample and create a new Key Range containing the Sample, drag the 
Sample from the Catalog onto the keyboard graphic. Keys hilight as you drag over 
them; the assignment is made when you release the mouse button.
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Dragging to the middle of an existing range splits the range at the insertion point, 
with the new sample assigned to the top part.

Open Sample in Editor
The Open Sample in Editor button opens the selected Sample in your preferred 
external sample editing program, such as Peak, WaveLab, SoundForge, Spark, 
Alchemy, etc. Use the Preferences window’s Sample Editor parameter (in the 
Samples page) to select your preferred editor.

Korg’s factory samples cannot be edited
Note that Korg’s proprietary .kes sample files are encrypted, and so they cannot be 
opened in external editors. When a .kes sample is selected, the Open Sample in 
Editor button will be grayed out.

Re-Load Sample
The Re-Load Sample button re-loads the selected Sample from disk. Use this 
command after editing and saving a Sample using an external sample editor.

Zoom In and Zoom Out
The zoom buttons allow you to change the size of the keyboard graphic. 

Use the small keyboard to show a large keyboard range at one time, to get an 
overview of the entire Multisample.

Use the large keyboard when editing Multisamples with small keyboard ranges, 
such as drum kits.
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Resource Monitor
To process and synthesize audio, the OASYS PCI uses DSP and host (PowerPC) 
processing power, DSP and host memory, and DSP busses. This page can give you 
an idea of how much of these resources are being used. 

The Resource Monitor can display either a summary or a detailed report, as set in 
the Preferences window (described on page 108).

Host Processing
Average Load. This shows the average load on the host CPU.

Peak Load. This shows the maximum load on the host CPU.

Engine Memory. This shows the amount of RAM used by the OASYS PCI Engine.

Editor Memory. This shows the amount of RAM used by the OASYS PCI Editor 
program.

DSP 1-5

Summary view

If the Preferences window Resource Monitor parameter is set to Summary, this 
section of the window will simply display one meter for each DSP. The meter gives 
a basic estimate of the amount of resources used on the DSP, combining all the 
measurements described under Detailed, below.
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Summary is the default view for the Resource Monitor. 

Detailed view
The Detailed view shows a large amount of specific resource usage information, 
and is intended primarily for developers interested in the low-level workings of 
the system.
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If the Preferences window Resource Monitor parameter is set to Detailed, this 
section of the window will display the following meters for each DSP.

Processor.  This shows the amount of cycles used on the DSP, and is the main 
indication of the amount of DSP processing power being used.

Linear Memory. This shows the amount of external linear memory being used. 
Linear memory is used for tables.

Circular Memory. This shows the amount of external circular memory being used. 
This memory is used for effects, physical models, and so on.

Long Circ. Memory. This shows the amount of external long circular memory 
being used. This memory is primarily used for delay-based effects, including short 
delays, choruses, flangers, and so on.

DRAM Memory. This shows the amount of external DRAM memory being used. 
Each chip has 6 megabytes of DRAM, used primarily for samples and long delays.

Busses. There are three rows of lights, with each row representing one of the three 
internal bus types: Local, Left-Flowing, and Right-Flowing. 

Local Busses, shown in the top row, are the number of busses used within the DSP. 
These busses are separate from the inter-chip busses.

Left-Flowing Busses, shown in the middle row, are the inter-chip busses which flow 
from the slave DSPs to the master DSP. The left-flowing busses carry mixer 
channels and audio outputs.

Right-Flowing Busses, shown in the bottom row, are the inter-chip busses which 
flow from the master DSP to the slave DSPs. The right-flowing busses carry any 
audio or stream inputs.
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Catalog
The Catalog shows the OASYS PCI’s Program, Patch, and Effects files. The Catalog 
can be displayed either as a browser window, or as an outline view, as set in the 
Preferences window (as described under “Catalog Window,” on page 109).

Browser view
In the Browser view, there are five tabs, for Programs, Patches, Effects, 
Multisamples, and Samples; there are also three panels, showing three levels of the 
file system hierarchy.

Catalog (Browser view)

Programs, Patches, Effects, Multisample, and Sample tabs
The tabs select which file type the Catalog will show.

Panels

Left panel
All OASYS PCI Programs, Patches, Effects, Multisamples, and Samples are stored 
inside the OASYS PCI folder. Within the main OASYS PCI folder are folders for 
sound libraries, such as the Korg factory sounds and optional sound packages 
from Korg and third parties, or user projects, such as “TV Series Third Season 
Cues.”

The left-most panel shows these library and project folders.
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Center panel
When a folder is selected in the left-most panel, the folders within its Programs, 
Patches, Effects, Multisamples, or Samples folder (depending on which tab is 
selected) will be shown in the middle panel.

These folders will generally be sound categories, such as pianos, basses, synth 
pads, reverbs, delays, and so on.

Right panel
When a folder is selected in the middle panel, the right-most panel shows the files 
within that folder.

If there are any files are in the main or middle levels, they will also be shown.

Adjusting the size of the panels
You can adjust the size of each panel by dragging on the separator bars between the 
panels.

Outline view
In the Outline view, there are five tabs, for Programs, Patches, Effects, 
Multisamples, and Samples, and a Finder-style expandable view of files and 
folders.

Catalog (Outline view)
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Programs, Patches, Effects, Multisamples, and Samples tabs
The tabs select which file type the Catalog will show.

List of files and folders
The outline view works just like the Finder’s “View by Name” option. 

Folders appear with a folder icon, with an arrow to the left of the icon. When the 
arrow is pointing to the right, the folder is closed, and its contents are hidden. 
When the arrow is pointing down, the folder is open, and its contents are shown.

To open or close a folder, simply click on its arrow.

Selecting Files (Browser or Outline view)

Selecting Programs
To select a Program, drag a Program file from the Catalog into a Mixer Channel 
Input slot, or into the Channel Parameters window. Alternately, select the slot and 
then double-click the name of the Program in the Catalog.

For more information, see “Loading a Program into a Multi,” on page 13.

Selecting Patches
To select a Patch, drag a Patch file from the Catalog into a Patch slot in a Program 
Edit window. Alternately, select the slot and then double-click the name of the 
Patch in the Catalog.

For more information, see “Adding a Patch to a Program,” on page 19.

Selecting Effects
To select an Effect, drag an Effect file from the Catalog into an Effects slot in a 
Mixer, Send Busses, or Output Busses window. Alternately, select the slot and then 
double-click the name of the Effect in the Catalog.

For more information, see “Adding Effects to Mixer Channels, Send Busses, and 
Output Busses,” on page 23.

Selecting Multisamples
To select a Multisample, drag an Multisample file from the Catalog into a 
Multisample slot in a Patch Control Panel. (Only sample-based Patches will have 
Multisample slots.) Alternately, select the slot and then double-click the name of 
the Multisample in the Catalog.

Selecting Samples
To select a Sample, drag an Multisample file from the Catalog into a Multisample 
Edit window. To create a new Key Range in the Multisample, drag the Sample 
onto the desired part of the keyboard; to replace the current Sample in a Key 
Range, drag the Sample into the Sample slot. Alternately, select the slot and then 
double-click the name of the Sample in the Catalog.
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File Menu
New

New creates a new Multi, and opens the new Multi’s Mixer window.

New Program
New Program creates a new Program, and opens its Program Edit window. When 
created in this way, the new Program will not be assigned to a Mixer Channel, so to 
play it, you need to save it to disk and then load it into the Mixer in the normal way.

Open…
Open brings up the standard Open File dialog, allowing you to open a Multi file.

Close
This command closes the window in the foreground. 

If a Mixer window is in the foreground, closing the Mixer window will also close 
the Multi to which the Mixer belongs. If the Multi has been edited, you will be 
prompted to save the Multi.

Save Multi
This command saves the current Multi. It will only appear when a Multi window is 
in the foreground (including the Mixer, Send Busses, and Output Busses windows).

Save Multi As…
Save Multi As… allows you to save the current Multi using a new name, or to a 
different location on disk.

It will only appear when a Multi window is in the foreground (including the Mixer, 
Send Busses, and Output Busses windows).

Save Program and Effects As…
This command allows you to save the current Program and its Insert Effects to a file 
on disk. The saved Program includes all Control Panel settings for all Patches and 
Insert Effects.

The command will only be shown when a Program Edit window is in the 
foreground.

Revert Multi
Revert Multi allows you to revert to the saved version of the current Multi.
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Connect/Disconnect
This command controls the connection between the OASYS PCI Editor and the 
OASYS PCI Engine. It switches between Connect and Disconnect, depending on 
the current state of the connection.

Connect causes the OASYS PCI Editor to hook up to the OASYS PCI Engine. If the 
OASYS PCI Engine is not already running, it will start up.

Disconnect causes the OASYS PCI Editor to un-hook from the OASYS PCI Engine. 
If the OASYS PCI Editor is the only program using the OASYS PCI Engine, then 
the Engine will quit, freeing system memory for other applications.

Play
This command starts the active Multi, if it has previously been stopped.

Stop
This command stops the active Multi. It can be used as a “Panic” or all-notes-off 
command.

Disable Meters/Enable Meters
This command controls all meters in the system, including those in Mixer 
windows, in control panels, and in the Resource Monitor. It switches between 
Disable and Enable.

Disable Meters causes all meters to go blank. This can be used to free up host 
CPU processing resources, if things are getting really tight–though this should 
rarely be necessary.

Enable Meters returns all meters to normal functioning.

Quit
This command quits the OASYS PCI Editor. If there are unsaved Multis, you will 
be prompted to save them.
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Edit Menu
Undo

This command undoes the last edit action. When possible, the command will show 
the action to be undone, such as “Undo Cut.”

Cut
The cut command deletes the selected Program, Patch, Effect, or numeric value, 
and places it on the clipboard.

Copy
This command copies the selected Program, Patch, Effect, or numeric value, and 
places it on the clipboard.

To copy a Program, Patch, or Effect to another slot, you can also use drag-and-drop. 
Just select the item and drag it onto the new slot.

Paste
This command pastes the contents of the clipboard into the current selection. Note 
that you can only paste data which matches the selection; for instance, a Program 
can only be pasted into a Program slot.

Clear
The clear command deletes the selected Program, Patch, Effect, or numeric value.

To clear a Program, Patch, or Effect, you can also just select the item and press the 
Delete key.

Select All
This selects all items.

Preferences…
This brings up the Preferences window, as described on page 109.

Audio Settings…
This brings up the Audio Settings window, which duplicates the ASIO control 
panel, as described on page 117.
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Windows Menu
Catalog

This opens the Catalog palette, as described on page 102.

Modulation Palette
This opens the Modulation Palette window, as described on page 91.

Resource Monitor
This opens the Resource Monitor window, as described on page 99. If the window 
is already open, it is brought to the foreground.

Mixer
This brings the Mixer window, as described on page 60, to the foreground.

Send Busses
This opens the Send Busses window, as described on page 68. If the window is 
already open, it is brought to the foreground. 

On Windows computers, you can also use the command ALT-W-S.

Output Busses
This opens the Output Busses window, as described on page 72. If the window is 
already open, it is brought to the foreground.

On Windows computers, you can also use the command ALT-W-O.

Channel Parameters
This opens the Channel Parameters window, as described on page 77. If the 
window is already open, it is brought to the foreground.

On Windows computers, you can also use the command ALT-W-P.

List of Open Windows
A list of all open windows is shown at the bottom of the menu.
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Preferences
The Preferences window can be opened by selecting “Preferences…” from the Edit 
menu (as described on page 107).

When you make a change in the Preferences window, it does not take effect 
immediately. After you have set the preferences as desired, press the window’s 
“Save” button to apply the changes.

There is no need to close the Preferences window; if you wish, you can leave it open 
all the time.

General tab
The General tab contains parameters for controlling what the OASYS PCI Editor 
does at start-up, the appearances of the Catalog and Resource Monitor windows, 
the location of the OASYS PCI folder, the way that Multis are downloaded to the 
DSPs, and the Host Processing rates. All of these parameters are described in detail 
below.

On Start Up
Don’t Open or Create a Multi.  When the OASYS PCI Editor starts up, no Multi 
will be opened; you will need to create a new one or open one manually.

Create New Multi.  This automatically creates a new Multi when the OASYS PCI 
Editor is opened.

Open a Multi.  When the OASYS PCI Editor starts up, an Open dialog will appear, 
allowing you to select a Multi to open.

Connect to Engine
On, Off. This automatically connects the OASYS PCI Editor to the OASYS PCI 
Engine. The two must be connected in order to play and process sounds in the 
OASYS PCI Editor. The default is On.

Catalog Window

Style (MacOS)
Outline.  This shows the files in the style of the MacOS Finder window. Folders are 
shown with arrows to the left of their name; click on the arrows to open and close 
the folders.

Browser.  This shows the files in a three-panel file browser, so that you can easily 
navigate through sub-folders.

Open on Start Up
Always. With this setting, the Catalog will always appear when the OASYS PCI 
Editor is opened.

Never. With this setting, the Catalog will not be opened at startup.
OASYS PCI 109



Preferences Reference

E
ng

lis
h

Remember. With this setting, the Catalog will be opened at startup if it was open 
the last time the OASYS PCI Editor was closed.

Host Processing
Synthesis and Effects algorithms predominantly use the onboard DSPs, but also 
sometimes use the main CPU, the “host,” for some non-audio functions, such as 
non-audio-rate LFOs. The algorithms prioritize different host functions, so that 
they are updated at one of four rates, and therefore use only the necessary amount 
of CPU processing power. These four parameters set those update rates. 

To change the amount of CPU processing power used, you can adjust these rates. 
Doing so may affect the sounds of some algorithms, however.

Host Rate 1. This is the update rate, in milliseconds, for Host Rate 1. The default 
value is 4. This is generally used for non-audio-rate LFOs.

Host Rate 2. This is the update rate, in milliseconds, for Host Rate 2. The default 
value is 8.

Host Rate 3. This is the update rate, in milliseconds, for Host Rate 3. This also sets 
the update rate for all audio meters. The default value is 30.

Host Rate 4. This is the update rate, in milliseconds, for Host Rate 4. The default 
value is 100.

OASYS PCI Folder Location
This parameter tells the OASYS PCI Editor the location of the OASYS PCI folder, 
which contains all of the Programs, Patches, Effects, and Scales for the OASYS PCI. 
Pressing the Choose button brings up a standard file dialog, allowing you to select 
the location of the folder.

If you need to move the OASYS PCI folder, or if the OASYS PCI Editor cannot find 
the folder, use the Choose button to select the correct folder.

Resource Monitor
This controls whether the Resource Monitor window (described on page 99) 
shows a summary or a detailed report.

Summary. With this setting, the Resource Monitor will show a concise summary of 
system resource usage. This is the default setting.

Detailed. With this setting, the Resource Monitor will show a detailed report of 
system resource usage. 

Multi Defaults

Master Output Bus
This sets the default Master Output Bus for new Multis. You can select any of the 
six Output Busses: Analog L-R, S/PDIF L-R, ADAT 1-2, ADAT 3-4, ADAT 5-6, or 
ADAT 7-8.
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Reset Master Output Bus When Opening Multis
On/Off.  When this is enabled, a newly opened Multi’s Master Output Bus will be 
changed to the default, as set above, regardless of the setting saved in the Multi. 
Use this feature if you always want to audition sounds through a specific Output 
Bus.

NOTE: If a Multi uses multiple Output Buses, changing the Master Output Bus 
may sometimes require the Programs and Effects to be re-arranged within the 
DSPs. This may either increase or decrease the effective amount of DSP processing 
power available. 

In extreme cases, if the Multi was already using up almost all of the available DSP 
processing power, it is possible that changing the Master bus may put things over 
the edge, making the Multi too big to be played. If this happens, disable the “Reset 
Master Output Bus” option, or take one of the other measures described under 
“Managing Resources” on page 53.

FX Auto-Load
On/Off.  This sets the default for the Mixer Channel’s FX Auto-Load parameter.

Miscellaneous

Voice Scaling
0 to -30dB. This parameter sets the amount of gain scaling for Program voices, to 
provide headroom in the mixer. -12dB is the default, and in most cases should 
provide reasonably high output level without clipping. At the minimum voice 
scaling of 0dB, voices will not be scaled at all, and two or more voices sent to the 
same channel or output bus may cause clipping.

Increasing the headroom (by dragging the slider towards -30dB) will further reduce 
the possibility of clipping, but will also lower the output level for all Programs.

Decreasing the headroom (by dragging the slider towards 0dB) will raise the 
output level for all Programs, but will also increase the possibility of clipping.

Control Panel Knob Throw
This sets the mouse dragging distance, in pixels, required to move a knob all the 
way from its minimum to its maximum.

MIDI/Global tab
This page contains basic setup parameters for the OASYS PCI.

MIDI Settings
These settings control the MIDI functions of the OASYS PCI.

MIDI System (MacOS)
This parameter selects the system by which the OASYS PCI will send and receive 
MIDI. The parameter appears only on MacOS systems; on Windows, OASYS PCI 
always uses standard Windows MIDI. 
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The OASYS PCI can appear as a MIDI device to OMS- and FreeMIDI-compatible 
programs, or can be used directly via the Macintosh serial ports.

OMS.  The OASYS PCI will use the Open Music System. Select this option for use 
with Vision, Studio Vision Pro, Logic Audio, Cubase VST, Cakewalk Metro, and 
other OMS-compatible applications.

FreeMIDI.  The OASYS PCI will use FreeMIDI. Select this option for use with 
Performer, Digital Performer, and other FreeMIDI-compatible applications. 

Serial. The OASYS PCI will connect directly to one of the Macintosh serial ports. 
Use the MIDI Port parameter, below, to select either the Modem port or the Printer 
port, and use the Port Speed parameter to set the speed of the MIDI interface.

Editor Responds to OMS/FreeMIDI Controllers (MacOS)
On/Off. This parameter only applies when the MIDI System parameter, above, is 
set to either OMS or FreeMIDI. It is similar in function to the “Local On/Off” 
setting on many synthesizers. 

If the box is checked, the OASYS PCI Editor will directly respond to MIDI 
controllers (keyboards, MIDI guitars, wind controllers etc.). If an OMS or 
FreeMIDI program is patching through MIDI input from the controller as well, this 
will cause the OASYS PCI to play two notes for every one that you play–one 
received directly, and the other received from the sequencer. This can cause 
various strange results, including phasing, hung notes, and notes cutting off 
prematurely.

If the box is not checked, the OASYS PCI Editor will not directly respond to OMS 
or FreeMIDI controllers. Instead, it will only receive MIDI data patched through 
from the sequencer or other MIDI program.

Editor Responds to MIDI from MIDI Input Device (Windows)
On/Off. This is similar in function to the “Local On/Off” setting on many 
synthesizers. 

If the box is checked, the OASYS PCI Editor will directly respond to MIDI 
controllers (keyboards, MIDI guitars, wind controllers etc.). If a MIDI program is 
patching through MIDI input from the controller as well, this will cause the 
OASYS PCI to play two notes for every one that you play–one received directly, 
and the other received from the sequencer. This can cause various strange results, 
including phasing, hung notes, and notes cutting off prematurely.

If the box is not checked, the OASYS PCI Editor will not directly respond to MIDI 
controllers. Instead, it will only receive MIDI data patched through from the 
sequencer or other MIDI program.

Serial Ports (MacOS)
This parameter only applies when the MIDI System parameter, above, is set to 
Serial.

Modem. The OASYS PCI will send and receive MIDI from the Modem port.
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Printer. The OASYS PCI will send and receive MIDI from the Printer port.

Interface Speed (MacOS)
This parameter only applies when the MIDI System parameter, above, is set to 
Serial.

1x. This is the normal MIDI interface speed.

Fast. Use this setting with multi-port interfaces (MIDI TimePiece, Studio 4/5/128, 
etc.) set to “fast” mode.

Global pitch bend range
Half Step, Whole Step, Min. 3rd, Maj. 3rd, Perfect 4th, Dim. 5th, Perfect 5th, Min. 
6th, Maj. 6th, Min. 7th, Maj. 7th, Octave.  This range is used for all Patches in 
which the Pitch Bend range is set to Global.

Tempo Delay Threshold
This controls the hysteresis for MIDI tempo delays. To compensate for uneven 
MIDI clock messages (which are quite common), the OASYS PCI suppresses small 
tempo changes for controlling delay times. Once a tempo is established, OASYS 
PCI will not change the delay tempo until it receives a certain number of clocks at a 
new tempo. This parameter sets the number of consecutive MIDI clock commands 
which must be received before changing the tempo.

Send MIDI Parameter Change Messages
On/Off. When this parameter is enabled, editing any parameter in the Effect and 
Patch Control Panels will send out a corresponding System Exclusive Parameter 
Change message. 

You can automate parameter changes by recording these messages into a MIDI 
sequencer, and then playing them back into the OASYS PCI. To receive the 
messages, the Receive MIDI Parameter Change Messages parameter, described 
below, must also be enabled.

For more information, please see “MIDI System Exclusive Format” on page 133.

Receive MIDI Parameter Change Messages
On/Off. When this parameter is enabled, System Exclusive Parameter Change 
messages can be used to control all Patch and Effect Control Panel parameters. For 
more information, see “Send MIDI Parameter Change Messages,” above.

Update Control Panel From MIDI
This only applies when Receive MIDI Parameter Change Messages, described 
above, is enabled.

On. When MIDI Parameter Changes Update Control Panel is enabled, incoming 
System Exclusive Parameter Change messages will move the knobs, sliders, etc. on 
the Control Panel, as well as updating the parameter values.
OASYS PCI 113



Preferences Reference

E
ng

lis
h

Off. When MIDI Parameter Changes Update Control Panel is disabled, incoming 
System Exclusive Parameter Change messages will update parameter values, but 
will not move the knobs, sliders, etc. on the Control Panel.

Update Mixer Windows From MIDI
On. Incoming MIDI controller messages will move the knobs, sliders, and buttons 
on the Mixer, as well as updating the parameter values.

Off. Incoming MIDI controller messages will affect the mixer settings, but these 
changes will not be shown on the knobs, sliders, and buttons.

Assignable Controllers A-H

Controller A-H.
These are the 8 assignable MIDI controllers, which are available in all Modulation 
Source menus. Each can be assigned to any MIDI continuous controller. 

Commonly used controllers are available in the menu. You can also enter any 
controller between 1 and 97 simply by typing its number in the value box.

Bipolar
The bipolar feature allows you to use MIDI controllers to modulate up and down 
around a center point. It can be enabled separately for each of the assignable 
controllers. 

On. When Bipolar is turned on for a given controller, MIDI values from 0-63 will 
produce negative modulation, a value of 64 will produce no modulation, and 
values from 65-127 will produce positive modulation. Negative “mod amount” 
settings will invert the effect. Use this for controllers with a default center position, 
such as ribbons or X-Y pads.

Off. MIDI values from 0-127 will produce positive modulation. Negative “mod 
amount” settings can be used to create negative modulation. This is the default for 
most controllers. 

Global Settings

Sample rate
This parameter has two functions. First, it sets the clock rate when the Clock 
Source parameter, described above, is set to Internal. Second, it sets the sample 
rate information embedded in the S/PDIF output data, which in turn sets the 
sample rate of any connected S/PDIF devices.

When transferring audio from the ADAT inputs to S/PDIF output, it is important 
to set this parameter so that it matches the sample rate of the ADAT. Since original 
ADATs used their pitch controls to choose between 48kHz and 44.1kHz, the 
OASYS PCI cannot be sure of the sample rate of ADAT input. Setting the Sample 
Rate parameter lets the S/PDIF device know what rate to expect. If this parameter 
is set incorrectly, the connected S/PDIF device may not function properly.
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VERY IMPORTANT: The sample rate affects the processing power available to the 
OASYS PCI. You’ll get about 8% more processing power for synthesizers and/or 
effects at 44.1kHz than at 48kHz.

44.1 kHz. The internal sample rate will be set to 44.1kHz. Also, the S/PDIF sample 
rate information will be set to 44.1kHz.

48 kHz. The internal sample rate will be set to 48kHz. Also, the S/PDIF sample rate 
information will be set to 48kHz.

Clock source
When connecting multiple digital audio devices–such as the OASYS PCI, an ADAT 
system, and a S/PDIF device–it is important that the word clocks of the devices be 
locked together. If the clocks are not locked, the audio may be marred by pops and 
clicks. The OASYS PCI can lock to incoming clocks from any of its digital inputs, or 
it can generate its own clock. For more information, see “A few words on word 
clock,” at the end of the System Configurations section of the Installation Guide.

You may need to select different clock sources from time to time, depending on 
what you are currently doing with the OASYS PCI; see the “System 
Configurations” section of the Installation Guide for details.

ADAT. The ADAT optical input will provide the master word clock.

S/PDIF. The S/PDIF input will provide the master word clock.

Word Clock. The BNC word clock input will provide the master word clock.

Internal. The OASYS PCI’s internal clock will be the master. With this setting, the 
Sample Rate parameter, described above, controls the clock.

Master Fine Tune
+/- 100 cents. This allows you to make small adjustments to the global pitch of the 
OASYS PCI, in cents. A cent is 1/100 of a semitone. 

Sample Tab
This page contains sample-related preferences.

Default Multisample File
This parameter selects the Multisample which will appear in a new, blank PCM 
Patch.

Choose... button
To select any Multisample file on disk, press the Choose button; a standard file 
dialog will appear, allowing you to select the file to use.

Set to (none) button
If you would prefer not to load any Multisample when opening a new, blank PCM 
Patch, press this button. The Default Multisample will be set to (none).
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Sample Editor
On the Multisample Edit page, there is a button named Open Sample In Editor. 
When this button is pressed, the current Sample will be opened in a sample editing 
program, such as Spark, Peak, Wavelab, etc. This preference selects which 
program to use.

Choose... button
To select the sample editing program, press the Choose button. A standard file 
dialog will appear, from which you can select the desired program.

Factory Settings
Pressing this button restores the factory default preferences. After recalling the 
factory defaults, you will still need to press the Save button in order for them to 
take affect.

Revert
Pressing this button reverts all preferences to the last saved settings.

Save
Pressing this button applies any changes that you have made, and saves them to 
the OASYS PCI Editor Preferences file.
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ASIO Control Panel/ 
Audio Settings
MacOS control panel

This window can be accessed via the OASYS PCI Editor’s Edit menu Audio 
Settings… command, via the Windows Wave Device Settings window’s Audio 
Settings… button, or via ASIO-compatible software.

On MacOS systems, it will be named Audio Settings when reached from the Audio 
Settings command, and ASIO Control Panel when reached from an ASIO program. 
On Windows, it will always be named Audio Settings.

To open the ASIO Control Panel from within an ASIO program, you will generally 
press a button in the window used to configure the program’s audio hardware. The 
location and name of this configuration window will vary depending on the 
program being used; please consult your program’s manual for details.

NOTE: To view the window at full resolution, zoom in to 200%.
OASYS PCI 117



ASIO Control Panel/ Audio Settings Reference

E
ng

lis
h

Windows 95/98/ME control panel

General

ASIO
ASIO stands for “Audio Stream Input/Output,” and is a method for 
communicating audio between software and I/O hardware. The OASYS PCI 
offers multichannel audio support for all ASIO-compatible digital audio software, 
including Cakewalk Metro, Cool Edit Pro, Cubase VST, Digital Performer, Logic 
Audio, Vision DSP and Studio Vision Pro, and more. 

Before using the OASYS PCI with ASIO software, the OASYS PCI ASIO driver 
must be installed, and the OASYS PCI must be selected as the software’s ASIO 
device. For more information, please see the “Configuring ASIO Software” section 
in the Installation Guide, and the manual for your digital audio software.

Windows audio programs
Before using the OASYS PCI with Windows audio programs, various settings 
should be made in Windows. For more information, please see the “Configuring 
MME (Windows)” section in the Installation Guide, and the manual for your 
digital audio software.

Zero-Latency Monitor Mixer
The OASYS PCI includes a built-in, zero-latency monitor mixer, so that you can 
listen to inputs during recording without any audio delay. You can adjust the 
volume level for each input, and route each input to any output.

NOTE: To view the window at full resolution, zoom in to 200%.
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These output routing and volume settings affect only the monitor mixer; they do 
not have any affect on audio recorded into or played back from the digital audio 
program.

Programs which support ASIO 2.0 can automatically control the monitor mixer’s 
levels and output routings, matching the volume and output settings of record-
enabled tracks.

Note that you can also use the main mixer to set up effects for monitoring, such as 
reverb on a vocal. For more information, see “Record monitoring with effects,” on 
page 47.

On/Off Button
This allows you to turn the entire monitor mixer on and off.

Volume
-Inf, -139dB to 0dB. This sets the monitor volume for the selected input. At the 
maximum value of 0dB, the volume of the input signal will be unchanged. At lower 
values, the volume will be reduced. At the minimum value of 
-Inf dB (infinite gain reduction), the input signal will be completely muted.

Output
Analog L & R, ADAT 1-8, S/PDIF L & R. This selects the output channel to which 
the input will be routed. Any of the twelve inputs–Analog left and right, S/PDIF 
left and right, and ADAT 1 through 8–may be routed to any of the twelve outputs.

Multiple inputs may be sent to the same output. This section is not designed as a 
full-fledged mixer, however, and so there is an important limitation: no additional 
headroom is provided when mixing multiple inputs to a single output. To avoid 
clipping, you’ll need to reduce the volumes of the input channels.

Analog Trims
You can use the analog input and output trims to adjust for variations in analog 
signal levels. Note that these apply only to the analog I/O, and do not affect the 
ADAT or S/PDIF levels.

Unlike the volume controls in the monitor mixer, the analog trims affect all analog 
signals to and from the OASYS PCI, including recording and playback to and from 
digital audio software.

Input Level
-72dB to +18dB. This allows you to control the input sensitivity of the analog 
inputs, prior to the A/D conversion. At the default value of 0dB, the volume of the 
input signal will be unchanged. At higher values, the volume will be increased; at 
lower values, the volume will be reduced. 
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In general, it’s best to leave the Input Level set to 0dB, and attenuate only when 
necessary to avoid digital clipping. If you’re using an external mixer, you may find 
it more convenient to reduce the output level of the mixer. 

Output Level
MUTE, -72.1 dB to 0dB. This controls the gain of the analog outputs. At the 
default value of 0dB, the volume will be unchanged. At lower values, the volume 
will be reduced.

Record Source
The OASYS PCI allows you to record from either the audio inputs, or the output of 
the OASYS PCI mixer. 

Audio Inputs
When this option is selected, the digital audio program will record from the audio 
inputs of the OASYS PCI. This allows you to record audio from any external 
source connected to the analog, S/PDIF, or ADAT inputs.

Mixer Outputs
When this option is selected, the digital audio program will record from the 
outputs of the OASYS PCI mixer. This allows you to record OASYS PCI 
synthesizers, and audio processed through OASYS PCI effects, without making 
any external audio connections. 

The mixer outputs are routed to the corresponding inputs in the digital audio 
program, so that mixer output ADAT 3-4 is heard at input ADAT 3-4, and so on.

You can even simultaneously record audio inputs along with processed audio and 
synthesizers, simply by assigning OASYS PCI mixer channels to the desired audio 
inputs.

Audio Buffer Size
64, 128, 256, and 512 samples. This sets the size of the buffers used when sending 
audio data between the OASYS PCI and digital audio programs.

Smaller settings allow you to decrease CPU input-to-output latency, at the expense 
of slightly higher CPU loading. 

Larger settings allow you to maximize CPU efficiency, at the expense of higher 
CPU input-to-output latency.

Depending on the speed of the CPU, the amount of CPU-based plug-ins you are 
running, the speed of the audio disk, and other factors, some computers may 
require higher Audio Buffer Size settings than others. Settings which are too small 
may cause clicks or other audio artifacts. You may need to experiment to find the 
best setting for your system.

After changing this setting, you’ll need to reboot before using the OASYS PCI.
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NOTE: The Audio Buffer Size affects only the CPU input-to-output latency–the 
amount of time that it takes to route audio from the OASYS PCI inputs, through a 
CPU-based digital audio program (and that program's CPU-based real-time 
effects), back to the OASYS PCI outputs.

DSP input-to-output latency–the amount of time that it takes to trigger notes when 
playing OASYS PCI synths, or to route live audio inputs through OASYS PCI 
effects–is unaffected by the Audio Buffer Size.

Do you need to minimize latency?
There are two situations in which minimum CPU latency is desirable:

• Playing CPU-based synths, such as VST instruments, from a MIDI controller
• Using CPU-based effects, such as VST or DirectX, to process realtime audio 

inputs (such as playing a guitar through VST effects)
If you are doing either of these two things, then you may wish to adjust the Audio 
Buffer Size and ASIO Out Latency (Windows only) parameters to the lowest 
settings which work with your computer system.

If you are not doing either of these two things, then you should leave the Audio 
Buffer Size and ASIO Out Latency (Windows only) parameters set to their default, 
maximum values.

ASIO Out Latency (Windows)
2, 3, and 4 buffers. This sets the number of audio buffers (see “Audio Buffer Size,” 
above) used for ASIO output. This affects ASIO output only; it does not affect ASIO 
input, or MME input and output. 4 buffers is the default setting.

The total output latency is equal to the buffer size multiplied by the number of 
buffers. For instance, with an Audio Buffer Size of 128 samples and ASIO Out 
Latency set to 2 buffers, the total ASIO output latency is 256 samples, or about 5 
milliseconds at 48 kHz.

Depending on the speed of the CPU, the amount of host-based plug-ins you are 
running, the speed of the audio disk, and other factors, some computers may 
require higher settings than others. Settings which are too small may cause clicks or 
other audio artifacts.You may need to experiment to find the best setting for your 
system.

After changing this setting, you’ll need to reboot before the new settings take effect.

Mute All
Pressing this button mutes all the inputs, so that all inputs receive only the purest, 
cleanest, most eminently silent digital black. Pressing the button again restores the 
previous settings of the window.
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Through All
Pressing this button sends all inputs to their corresponding outputs, so that ADAT 
1 in goes to ADAT 1 out, ADAT 2 in to ADAT 2 out, and so on. All volumes are set 
to full, and all phases are set to normal. Pressing the button again restores the 
previous settings of the window.

Retrieve Preferences
Pressing this button re-loads the saved settings for the window.

Save to Preferences
Pressing this button saves the current settings to the OASYS PCI Driver 
Preferences file. The saved settings will be automatically loaded on startup.
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Wave Device Settings 
(Windows)

General
Through the OASYS PCI’s standard wave device driver, the card can be used by 
any standard Windows digital audio program. The OASYS PCI appears as six full-
duplex stereo cards, one for each input/output pair, as well as four stereo output-
only devices for the eight Streams. 

Programs which support multichannel I/O have simultaneous access to all 12 
inputs and 20 outputs, up to the limits of the program itself. 

The OASYS PCI Wave Device Settings program controls the card’s sample rate, 
word clock source, and play/record synchronization. Optionally, it also lets you set 
volume and balance for each output device. From this program, you can also call 
up the Audio Settings, Hardware Meters, and Diagnostics windows.

NOTE: This window only affects audio I/O with standard Windows audio drivers. 
It does not affect use with ASIO programs. Additionally, the volume and balance 
controls apply only to audio program outputs; they do not control the output levels 
of OASYS PCI synths and effects.

NOTE: To view the window at full resolution, zoom in to 200%.
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Clock

Clock source
When connecting multiple digital audio devices–such as the OASYS PCI, an 
ADAT system, and a S/PDIF device–it is important that the word clocks of the 
devices be locked together. If the clocks are not locked, the audio may be marred 
by pops and clicks. The OASYS PCI can lock to incoming clocks from any of its 
digital inputs, or it can generate its own clock internally. For more information, see 
“A few words on word clock,” at the end of the System Configurations section of 
the Installation Guide.

You may need to select different clock sources from time to time, depending on 
what you are currently doing with the OASYS PCI; see the “System 
Configurations” section of the Installation Guide for details.

ADAT. The ADAT optical input will provide the master word clock.

S/PDIF. The S/PDIF input will provide the master word clock.

Word Clock. The BNC word clock input will provide the master word clock.

Internal Clock. The OASYS PCI’s internal clock will be the master. With this 
setting, the Sample Rate parameter, described above, controls the clock.

Sample rate
This parameter has two functions. First, it sets the clock rate when the Clock 
Source parameter, described above, is set to Internal. Second, it sets the sample 
rate information embedded in the S/PDIF output data, which in turn sets the 
sample rate of any connected S/PDIF devices.

When transferring audio from the ADAT inputs to S/PDIF output, it is important 
to set this parameter so that it matches the sample rate of the ADAT. Since original 
ADATs used their pitch controls to choose between 48kHz and 44.1kHz, the 
OASYS PCI cannot be sure of the sample rate of ADAT input. Setting the Sample 
Rate parameter lets the S/PDIF device know what rate to expect. If this parameter 
is set incorrectly, the connected S/PDIF device may not function properly.

VERY IMPORTANT: The sample rate affects the processing power available to 
the OASYS PCI. You’ll get about 8% more processing power for synthesizers 
and/or effects at 44.1kHz than at 48kHz.

44.1 kHz. The internal sample rate will be set to 44.1kHz. Also, the S/PDIF sample 
rate information will be set to 44.1kHz.

48 kHz. The internal sample rate will be set to 48kHz. Also, the S/PDIF sample 
rate information will be set to 48kHz.

Synchronization
Through the standard Windows driver, each of the OASYS PCI’s stereo input and 
output pairs appears to the system as an independent wave device. The digital 
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audio program must start recording or playback on each of them, one at a time. If 
left uncorrected, this would cause small offsets between the stereo pairs.

The Synchronization settings solve this by creating a group of synchronized input 
and output pairs. The OASYS PCI will not start either recording or playback until 
all of the devices in the group have received the start command from the digital 
audio program.

Auto Sync
When Auto Sync is enabled, synchronization happens automatically. Whenever 
you select or de-select a OASYS PCI input or output pair in your digital audio 
program, Auto Sync will add or delete the pair from the synchronization group.

This should work well for most applications; however, you can also disable Auto 
Sync, and makes settings manually using the Custom Synchronization window 
(under the Custom button).

Custom…
Pressing this button brings up the Custom Synchronization window, which allows 
you to manually control the OASYS PCI’s wave device synchronization. For more 
information, see “Custom Synchronization,” on page 128.

When Auto Sync is checked, the Custom button is disabled, and any settings 
previously made in the Custom Synchronization window will be ignored.

Volume/Balance Control
Each stereo I/O pair has a Control Enable button, which allows you to enable and 
disable volume and balance control for that stereo pair. These buttons allow you to 
enable or disable all of these buttons at once.

For more info on the Control Enable buttons, see “Control Enable” on page 126, 
below.

Unless you have a specific need for volume and balance control in this window, we 
recommend that you disable all Control Enable buttons. This will save CPU 
processing power; for more information, see “When to use volume/balance 
control” on page 126. 

Enable All
Pressing this button turns on all of the Control Enable buttons at once.

Disable All
Pressing this button turns off all of the Control Enable buttons at once.

Volume slider
Each stereo output pair has a volume slider, which controls the overall output level 
for the wave device. To adjust the left and right channels independently, use the 
balance slider in conjunction with the volume slider. 
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Moving the slider to the top of its range provides the maximum output level; 
moving it to the bottom of its range will mute the output.

The volume control is only active when the device’s Control Enable button is on. If 
your digital audio application provides its own volume controls, then the volume 
control provided here may be unnecessary, and you can save some CPU 
processing power by disabling it. For more information, please see “Control 
Enable” on page 126.

Please note that wave device volume and balance adjustment apply only to output 
(playback). You can adjust the input sensitivity of the analog inputs using the 
OASYS PCI Audio Settings control panel; for adjusting audio input level from 
ADAT or S/PDIF sources, we recommend that you use an external mixer. 

Also, note that the volume and balance controls apply only to audio program 
outputs; they do not control the output levels of OASYS PCI synths and effects.

Balance knob
Each stereo output pair has a balance knob, which controls the relative output 
levels of the left and right channels.

The balance control is active only when the device’s Vol/Bal On box is checked. 
For more information, please see “Control Enable,” below.

Control Enable
NOTE: This parameter only affects the volume and balance controls in the Wave 
Device Settings window. It has no affect on volume, balance, or pan controls in 
audio/MIDI software.

The Control Enable buttons allow you to enable or disable volume/balance 
control for each wave device, as desired. To enable volume/balance control for a 
particular device, turn on the Control Enable button below the device’s volume 
slider; to disable volume/balance control, turn the button off. 

You can turn all of the buttons on or off at once by using the Enable All and 
Disable All buttons at the left side of the window.

Volume and balance controls consume CPU resources, and so we recommend that 
volume/balance control remain disabled except when needed. For more 
information, see below.

When to use volume/balance control
The volume and balance controls are provided for use when playing back system 
sounds, or for use with simple wave applications without a volume control (such 
as the Windows Media Player). In these cases, the volume and balance controls 
will be helpful. 

However, they do consume some of the real-time resources of the CPU. When 
volume/balance control is enabled for a wave device, every sample passed to the 
device gets scaled by the current volume and balance settings.
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If you are using the OASYS PCI with an application that already provides volume 
control, or if you have an external means of adjusting the playback volume, then 
you can get better performance from your PC by disabling the wave device 
volume/balance controls. 

Device Status
Each stereo pair includes status lights, showing you whether they are currently 
playing, recording, or both (note that the Streams are outputs only, so they do not 
have record status lights).

Audio Settings…
Pressing this button brings up the Audio Settings window, as described on 
page 117. This window includes controls for the monitor mixer, analog input trims, 
a toggle to switch between recording from inputs and recording from the OASYS 
PCI mixer outputs, and more. 

Hardware Meters…
Pressing this button brings up the Hardware Meters window, as described on 
page 130. This window includes meters showing the audio levels at the physical 
outputs, including signals from both the audio DMAs (the outputs of audio 
programs) and the OASYS PCI mixer. 

Diagnostics…
Pressing this button brings up the Diagnostics window. This window contains low-
level information about the OASYS PCI software and hardware, and is intended for 
use by repair centers and technical support personnel.

Save As Defaults
Pressing the Save As Defaults button saves the current settings into the Windows 
System Registry. Once saved to the registry, these become the default settings, and 
will be loaded whenever the system boots. 

Retrieve Defaults
Pressing the Retrieve Settings button restores the default settings from the 
Windows System Registry. The default settings are stored by the Save As Defaults 
button, described above.

Help
Pressing the Help button brings up the Microsoft Windows Help file for the OASYS 
PCI, with lots of helpful, hypertext-linked information.
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OK
Pressing the OK button saves all changes, and quits the Korg OASYS PCI Wave 
Device Settings program.

Custom Synchronization

As discussed under “Synchronization,” on page 124, each of the OASYS PCI’s 
stereo pairs of inputs and outputs appear as an independent wave device. When 
the Auto Sync button is turned on, all of the wave devices will be grouped 
together so that they operate as a single, synchronized multichannel I/O device. 

Auto Sync is an easy-to-use, fool-proof mode optimized for working with 
multichannel audio programs. However, you can also use multiple audio 
programs at once, each connected to different sets of stereo I/O pairs. In this case, 
you should use the Custom Synchronization settings instead.

The Custom Synchronization settings allow you to manually create one group of 
stereo pairs which start to play back and/or record at the same time (for use with a 
multichannel audio program), while all of the other inputs and outputs operate 
independently. 

Note that if you use multiple “independent” wave devices with a single 
multichannel audio program, you may sometimes notice delays between the 
different stereo pairs.

NOTE: When Auto Sync is enabled in the Wave Device Settings window, any 
settings in the Custom Synchronization window will be ignored.

Sync Rec
Each of the input pairs has its own Sync Rec button. If one or more of these is 
turned on, the OASYS PCI will not start recording or playback until all of the 
devices set to Sync Rec have received the “start record” command from the digital 
audio program.

When recording from multiple input pairs simultaneously, make sure that each 
active input’s Sync Rec button is turned on, and that all of the inactive inputs’ Sync 
Rec buttons are turned off.

NOTE: To view the window at full resolution, zoom in to 200%.
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When you are not recording, make sure that none of the Sync Rec buttons are 
turned on. If any of them are turned on, then playback will not be able to start.

Sync Play
Similarly, each of the output pairs has its own Sync Play button. If one or more of 
these is turned on, the OASYS PCI will not start playing or recording until all of the 
devices set to Sync Play have received the “start play” command from the digital 
audio program.

When playing from multiple output pairs simultaneously, make sure that each 
active output’s Sync Play button is turned on, and that all of the inactive outputs’ 
Sync Play buttons are turned off.

When you are not playing back any audio–for instance, if you are recording into a 
new file–make sure that none of the Sync Play buttons are turned on. If one or more 
of them are turned on, but no audio is actually being played back, then recording 
will not be able to start.

What happens to un-synced input or output pairs?
When one or more stereo pairs are set to Sync Rec or Sync Play, the other stereo 
pairs cannot play or record until all of the synced pairs have been started. 

For instance, let’s assume that there are two audio programs running at the same 
time. Program A is using ADAT 1-2 and S/PDIF, and Program B is using ADAT 5-6. 
The Sync Rec boxes are checked for ADAT 1-2 and S/PDIF, and are un-checked for 
all other pairs, including ADAT 5-6.

If you press “record” in Program B, but Program A is idle, the card will not start. As 
long as Program A’s inputs are set to Sync Rec, you must start recording in Program 
A before you can record in Program B.

On the other hand, if you turn off the Sync Rec buttons for ADAT 1-2 and S/PDIF, 
then both programs can record freely, without waiting for one another.

Sync Record

Enable All
Pressing this button sets all of the “Sync Rec” check-boxes at once.

Disable All
Pressing this button clears all of the “Sync Rec” check-boxes at once.

Sync Playback

Enable All
Pressing this button sets all of the “Sync Play” check-boxes at once.

Disable All
Pressing this button clears all of the “Sync Play” check-boxes at once.
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OK
Pressing the OK button returns you to the main Korg OASYS PCI Wave Device 
Settings window.

Hardware Outputs

This window shows the levels at the hardware outputs of the OASYS PCI, after the 
OASYS PCI Output Busses have been summed with the direct outputs from any 
audio programs. 

For a complete signal flow diagram of the OASYS PCI, please see the graphic titled 
“Overall audio block diagram” on page 67.
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Scales
The OASYS PCI’s Scales allow any incoming MIDI note to create any pitch, with a 
resolution of a single cent (1/100 of a semitone). Using Scales, you can create stretch 
tunings, historic European tunings, scales with greater or fewer than 12 tones per 
octave, and more. 

Each Patch in a Program may have its own Scale, as assigned on the Program Edit 
page (see page 80). 

Each Scale is stored as an individual file in the “Scales” folder, within the Korg 
section of the OASYS PCI folder. 

Editing Scales
Scales are text files, and can be edited using any standard text editing program, 
such as SimpleText. Each file contains a single Scale. 

Syntax
Tuning can be specified separately for each of the 128 MIDI notes. Each note must 
be on a separate line; blank lines are OK. 

Each re-tuned note needs to have at least three entries: the incoming MIDI note, the 
resulting pitch (a note name), and fine tuning (+/- 100 cents). Entries must be 
separated by either spaces or tabs. Anything after the fine tuning is ignored, so you 
can put comments at the ends of the lines. 

For instance, below is a valid entry, including a comment, which causes a MIDI 
note of D2 to be remapped to F3 (E3 plus 100 cents, a full half-step):

d2 E3 +100 D2 becomes F3.

There doesn’t need to be a line for every MIDI input note. If no re-tuning is 
specified, that note will simply be sent straight through to its normal pitch, A1 to 
A1, C#3 to C#3, etc. If you want to have an entry for every note, you can also just 
map input straight to output, as shown below:

F4 F4 0 Also could simply not use an “F4” entry.

Symbols
Notes must always include both letter and octave number.

Note letters can be lower or upper-case, so both “d2” and “D2” have the same 
result. 

The # sign is used for sharp. Flat notes should be expressed as sharp notes; for 
instance, use A# instead of Bb. 

Note and tuning range
The valid range of notes is C-1 to G9. 
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Cent values for fine tuning must be integers in the range of -100 to +100. For 
positive values, the + sign is optional. 

C-1 cannot be fine-tuned down. G9 can be tuned up, however.
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MIDI System Exclusive Format
All objects on the Control Panel–knobs, sliders, and so on–can send and receive 
MIDI System Exclusive parameters, for automation with MIDI sequencer 
programs. For information on enabling System Exclusive send and receive, please 
see “Using Modulation” on page 30.

SysEx Messages are tied to Channel and slot
The System Exclusive messages are tied to the particular Mixer Channel/Send 
Bus/Output Bus and Slot, so that messages from Effect 2 on Channel 3 are separate 
from those of Effect 4 on Channel 7. If you move a Program, Patch, or Effect to a 
new slot or Channel, Send Bus, or Output Bus, previously recorded System 
Exclusive messages will no longer work properly.

Changing the MIDI Channel used by the Mixer Channel, Send Bus, or Output Bus 
will not affect the System Exclusive messages to and from the Patches and Effects; 
they will continue to work as they did before. So, for instance, SysEx recorded for 
mixer channel 1 will always affect mixer channel 1, regardless of its MIDI channel.

SysEx Format
Due to the plug-in nature of OASYS PCI synths and effects, there is no fixed System 
Exclusive format. Instead, SysEx is generated separately by each individual plug-
in. If you want to control a particular parameter via SysEx, the easiest method is to 
simply enable System Exclusive send and receive in OASYS PCI, and then just 
record knob/slider/button movements into your sequencer. This way, you don't 
need to be concerned at all about the specifics of the SysEx format.

If you do wish to work directly with OASYS PCI SysEx, then read on.

OASYS PCI SysEx data encodes the mixer channel or bus, the Effect or Patch slot, 
and the Control Panel item ID (each knob, button, menu, etc. has a unique ID). The 
MIDI channel is ignored, and the handling of the sysex messages relies on the 
mixer channel or bus number encoded in the message.

Each SysEx message has 13 bytes, as described below:

0: 0xf0 (SysEx header)

1: 0x42 (Korg manufacturer ID)

2: 0x3n (n = MIDI channel MOD 16 - no difference between A and B ports)

3: 0x55 (OASYS PCI Model ID)

4: 0x42 (Parameter change message ID)

5: a (Channel/Bus/Patch ID info)

6: b (Mixer Channel or Send/Output Bus number)

7: c (Parameter ID LSB)
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8: d (Parameter ID MSB)

9: e (Parameter value byte 0 (LSB)) - bits 0…6 of parameter value

10: f (Parameter value byte 1) - bits 7…13 of parameter value

11: g (Parameter value byte 2) - bits 14…20 of parameter value

12: h (Parameter value byte 3 (MSB)) - bits 21…23 of parameter value

13: 0xf7 (EOX end of SysEx message)

Determining the Parameter ID and value range for a specific parameter
To determine the parameter ID and value range for a particular Control Panel 
knob, fader, button, or menu:

1. Enable SysEx transmission in OASYS PCI.

2. Start recording in your sequencer.

3. Move the Control Panel parameter.

This will generate SysEx data, which will be recorded by the sequencer.

4. Examine the data recorded into the sequencer.

Maximum SysEx value
The maximum SysEx value for OASYS PCI is 8388607.
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